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Section 1: Overview 
Lab 1.1: Introduction and Overview

Hach Water Information Management Solution (WIMS)TM is a data management and reporting system.  It allows input/import of all plant data and outputs reports and graphs.  Data can be imported from SCADA systems such as GE iFix, Wonderware, RSView and many more.  Lab data can be manually entered or imported from LIMS systems such as Labware, Labworks, SampleMaster, etc. Input forms allow manual entry of operator data.
WIMS is a client server application that utilizes a centralized database (MS SQL or Oracle).  WIMS can be installed locally or accessed via the WIMS Online subscription service.  The locally installed (on premise) software is licensed by concurrent user and number of facility databases.  The online version is licensed by named users and data base size (MB).  See the appropriate Administration Guide for your on premise configuration.
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Logging into WIMS
To start WIMS, click on the WIMS menu item that was setup during install or double click on the WIMS icon that may have been setup.

The WIMS log on screen will be displayed.
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Enter your user name and password then Choose the “Tutorial – Sandy Beach WTP” facility:

Click the OK button.     [image: image3.png]QoK |





Please enter your user name and password in the space below for future reference:

User Name:    _______________________

Password:      _______________________
Main Menu
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The WIMS dashboard is displayed.  The icons are shortcuts to specific reports, data entry forms, or graphs.  Dashboards can be provided for each user. Dashboards with shortcuts to lab data entry forms and reports can be designed and operator dashboards can have shortcuts to their forms and reports.

These menu items in the toolbar reflect the functions available in WIMS:

File
Open a facility, set the default facility, or Exit WIMS 

Data Manager
Data entry and editing on either a monthly basis or over a user defined date range.

Report Pac
Outputs both built-in and user-defined reports.

Graph Pac
Displays graphs of your data.  These graphs and plots can be displayed on the screen or sent to a printer.

Design
Create and customize data entry forms and reports.

System Setup
Defines your facility, or facilities: Enter variables, equations, locations, and units setup.  Set system security by setting up user names and passwords to control entry to and access rights within WIMS.  

Modeling
Allows what-if analysis of your Wastewater Aeration and Clarifier systems.

Preferences
Set WIMS preferences such as default Export Folder, variable browser defaults, etc… Super Users and Managers are allowed to modify other users’ preferences.
Utilities
Allow changing your password, view and send WIMS messages, list sessions attached to the WIMS database, and export data to Excel.

Help
Find on-line answers about WIMS.
Section 2: Operator Training
NOTE: Specific dates used in text and examples is for illustration only.  Dates in your examples may be different. This training guide uses the Sandy Beach Tutorial database. 
Lab 2.1: Using Monthly Data Entry

Monthly Data Entry is used to enter data into WIMS.  This lab exercise demonstrates how to enter data into WIMS using a previously designed Monthly Data Entry (MDE) Form.
Introduction

Monthly Data Entry displays variables in a spreadsheet type layout for data entry and review.  Each column is a particular variable and each row represents a different day of the month.  The forms display one month at a time along with statistics for each variable at the bottom of each column.  Monthly Data Entry forms can be designed to display daily variables in any order.  

In this lab you will learn how to:

· Access a Monthly Data Entry Form

· Enter Data into the current month

· Review historical data

· Enter Result Comments

· Understand the status bar and colors

Lesson 2.1.1: Opening a Monthly Data Entry Form for use
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The data manager provides access to all types of data entry forms that have been created.  Choose any of the forms to enter data.  No matter which method is chosen, the data is stored in the database.  For example, you can use a custom data entry form to enter data and those same data points will appear on a monthly data entry form.  
STEP 1: Open “Influent Variables” Monthly Data Entry Form

1. To begin entering data, select Data Manager, Operator Forms from the main menu.

2. Double click on “Operator Entry and Review Form” (or click on it and then Click Open). 
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Your variables will be displayed for the current month.  The current entry cell is automatically set to the current day of the month.
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To begin entering data for the current day (March 5th in this case) move to the cell and type.  Press the [Enter] Key or use the mouse to move to another cell.  Data is automatically saved to the database when you leave the cell. 
STEP 2: Enter and Calculate Data in the Form
1. Enter the following Data into the appropriate cell: 
· Plant Flow Rate Influent #1

19.77

· Plant Flow Rate Influent #2

21.31

· Raw Water Nitrate

<1.1 The Raw Water Nitrate parameter has been setup    
                                                                to accept this type of entry in system setup.  Not all 
                                                                parameters will accept the “<” symbol, i.e. Plant Flow 
                                                          Rate Influent #1 does not accept the “<”. 

· Operator In Charge Shift 1
KSM (You can use the pull down list to select KSM or type “KSM”)
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Calculate the equations.  Clicking the Calc button near the upper right side of the screen will cause all of the equations to be calculated for all the days of the displayed month in which data has been entered. 

2. Click on the Calc Button in the upper right side of the screen. 
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Data is automatically saved as it is entered.  

3. To exit, select File, Exit or click the [image: image7.png]


 in the upper right hand part of the screen.
Lesson 2.1.2: Reviewing Data with MDE

Monthly Data Entry (MDE) Forms can be used to review historical data from previous months.  Open the form and use the date selection box to load a new month. Forms will be displayed for the current month.
Step 1: Load and Print the Influent Variables MDE Form for January of current year
1. From the Main Menu, Select Data Manager, Operator Forms and open “Operator Enty and Review “ MDE form.  

2. Use the Date Selector at the top of the form to January 2009 (in our example).
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Select Jan 2009, data will be loaded for the selected month, and browse the data.  The summary statistics for each parameter are listed at the bottom of the form.
3. Print the form. Select File, Print or click [image: image9.png]


 icon on the toolbar.
4. Exit the MDE form. Select File, Exit or click [image: image10.png]



Lesson 2.1.3: Monthly Data Entry Advanced Options

MDE allows entry of Daily Comments, Result Comments, and advanced troubleshooting options.  Result Comments are used to enter comments specific to the variable and date.  For example, the flow meter was calibrated so the entry is an estimate, you can flag that entry as such.  Daily Comments are typically used as a logbook function.
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Step 1: Entering Result Comments
1. Open “Operator Entry and Review” MDE form. Data Manager, Operator . Chose the correct month using the Date Selector:




2. Move to a cell where you want to enter a comment, Right Clicking to display the context menu and enter comment.  
3. Select “Result Comment” and the Sample Comment Entry Screen will be displayed.  
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4. Enter the text “Meter Calibrated, hand entered flow. GLS” and click OK.  [image: image13.png]QoK |
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A red dot in the upper right corner of the cell indicates Result Comments.  When you move to a cell with a Result Comment the result comment text is displayed in the status bar at the bottom of the screen. 

Step 2: Use Insert Column and List Inputs to Troubleshoot Calculations

When a calculated variable returns an unexpected result, look at the values that were used to calculate the value.  For example, how was the V763 Reservoir combined total was calculated.  
1. Click anywhere in the body of the form for the popup menu, insert V763, Right Click and select “Insert Column”.
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2. The variable browser will be displayed. Choose variable 763 and click OK.
[image: image15.png]Variable Browser.

© ok | @concel|  d Fnd [ serun

[& e ) wor| v rier -] @ 1ho| 5 v |

Locations_|

Var#_| Var Name

[Type

[_units

[Location

= AllLocations ™

[RawWater
Blender
Setted Water
Fiters

Fitered water
(Clearwel
[Frished water
(Chemical

Ciy

Lab

130
131
140
181
150
151
181
20
205
26
758
750

Operstar-in-Cherge S 1
Operstor St 1 Gracte
Operstar-in-Chrge Shift 2
Operstor St 2 Gracte
Operstar-in-Charge Shift 3
Operstor St 3 Gracte

Plart Hours n Operation

Daily Rain Fall

Daily Temperature High

Daily Temperature Low.

Reservoir #1 Current Level
Reservoi #2 Current Level
Reservior Thearetical Detetion Time.
Reservoir Percent of Capacty
Return Flow Totel

Diverted Water to ERB)

Electic Meter #2 (new) Reacing
Electic Meter #2 (new) Usedl

Text Parameter
Coloutedt
Text Perameter
Coloutedt
Text Perameter
Coloutedt
Coloutect
Parameter
Parameter
Parameter
Parameter
Parameter

Coloutedt
Coloutect
Coloutect
Parameter
Parameter
Coloutedt

Intls
Grace
Intls
Grace
Intls
Grace
Hours
Inches
DegF
DegF
Feet
Feet

General
Gerersl
Gerersl
Gerersl
Gerersl
Gerersl
Gerersl
Gerersl
Gerersl
Gerersl
Gerersl
Genersl

Genersl
Gerersl
Gerersl
Gerersl
Gerersl
Genersl




[image: image16.png]= B A8 &[T m«

™ Operator Entry and Review Form - Monthly Data Entry.
Fie Edt Fomat

Mar 2010 > | [ Monday. March 01. 2010 Comments | Cse | 5| &| Awmver?

Daily Limit Min |

Varinfo | 763 Reservoir Combined Total in MG [MG)

Max |

Equation | (V759-201)+(V760-284)

w0 it

1001 - Plant Flow | 1002 - Plant Flow | 763 - Reservoir | 1003 - Plant Total 1y
Rate Influent #2 | Combined Totaln|  Infueak L

Rate Irfluent #1
MGD

MGD

5001 - Frished | 5004 - Frihed | 130 UDeva
WalerPump | Waer Max
TotalFlow | Hour Flow ik
MG MGD

e Equation for

V763 2555

2805
2732
20 222

<t 2810
%72
2618
82 4

2720
2670

e PN




V763 Reservoir Combined Total in MG is inserted to the left of the current column.  The equation for V763 is displayed on the information panel at the top of the form.  Double click on the equation to display the translated equation.

[Reservoir Combined Total in MG [MG]] + ([Reservoir #1 Current Level [Feet]]  * .201) +               ( [Reservoir #2 Current Level [Feet]] * .284)
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Right Click on any day in the V763 column and select “List Inputs (1st Level)” to see values for V759 and V760.
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This inserts V759 and V760 to the right of the calculated variable. 

This makes it easy to see if there is an error in the inputs of a certain calculated variable. This will help troubleshooting of inaccurate or suspicious looking calculated data. 
Review Questions:

· Do you need to calculate to save data?

· How do you toubleshoot a calculated value

Lesson 2.1.4: Understanding the Status Bar 

Monthly Data Entry displays information about the entries in the status bar and by the format of the cell.  The following describes the settings and their meaning:
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	Bold, Lite Yellow background
	Entry is a Daily Violation



	[image: image18.png]17.030




	Italic, Lite Green background.
	Entry is outside the Entry Range
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	Bold, Italic, Lite Orange background
	Entry is outside of Entry Range and it also violates the Daily Limit.  
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	Red Dot
	Entry contains a Result Comment
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	Blue background
	Indicate Cells are Locked
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	Red Text
	Indicates calculated variable has been forced
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	Gray Text
	Cell is locked.  It is a calculated value, displays the average of a daily detail variable, or its data read-only flag in Edit/View Variables is set.


A cell can have more than one format.  For example, a cell could be Bold Italic with a red dot meaning it is a Daily Violation, is outside the Entry Range, and has a result comment.
In addition to the information shown above, the status bar at the bottom of the screen displays information about the current cell.
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Audit Trail

Audit trails indicate when and who entered, changed, deleted, or approved variable data.  This provides a history of the data, helps with compliance, and assures that you are using accurate data.  .  
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Using the Audit trail: 

Select Data Manager, Operator Forms, Operator Entry and Review Form,  right click on a cell to bring up pop up window
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The pop up window shows the audit trail information








Audit Trail Exercise:

1. Bring up a Daily Data Entry Form

2. Click on Effluent Flow 

3. Change the data from 2.587 to 3.210

4. Bring up the audit information and note audit trail entry


Other Topics: 
· Working with Daily Detail Variables in Monthly Data Entry

Lesson 2.1.5: Using Logbooks 

Used to enter, edit, and review Log Book Entries. A Log Book is a collection of notes organized by date and time. A note contains the name of the last user that edited it, the time at which the note was edited, and the text that was written. A Log Book can contain any number of notes. Any number of Log Books can exist. The system comes standard with one Log Book called Comments. More Log Books can be added by opening the Log Book Manager. For more information on how to create additional log books see Lesson 3.9.2: Organizing and Securing Data with Group Managers.
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Accessing a logbook:
· From Monthly Data Entry by double clicking on the Daily Com cell 
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From the main menu: Data Manager>Log Books









Adding an entry to a log book:
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In Monthly Data Entry, double click on the Daily Com cell to add a note for the date.  This brings up the Log Book Entry Form.

2. Click the Add Note button.

3. Enter your comment.  A Spell Check button is available.  Using Spell check will make searches easier in the future.

4. Click OK.  
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Edit an existing entry
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1. Click on the entry to edit

2. Click the Edit Note button

3. Edit the text

4. Click OK.  
Note:  You may not be able to edit an entry based on your Access Permissions for the logbook (covered in System Administrator Training).

Searching the Logbook
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Search for a keyword in the comment text.  For example, you remember we spilled some polymer a couple of months back, but cannot remember the exact day.  Find the logbook entries with the word “spill” for the last several months:

1. Click Find

2. Set the date range to search.  We choose Year to Date.

3. Enter the text to search for.

4. Click the Search Button

5. Double Click (or click the Select button) the comment to pull it up in the Log Book Entry form.  Searches are NOT case sensitive.
Review
Exercise - Monthly Data Entry

· Open the Operator Entry and Review  form 

· Enter 21.12 for the 10th and insert Variable 2 Influent Flow Hourly
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Insert the Calculated variable 1024 – Raw Water Turbidity Average NTU and list inputs for it:
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Make a Log Book comments for the 10th:
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Export the form to Excel.

Lab 2.2: Using Custom Data Entry

Custom Data Entry (CDE) is a powerful tool used to enter data into WIMS.  Custom Data Entry forms can be designed to enter values into variables or to calculate functions and store the results in designated variables.  Using these custom forms is demonstrated in the following lab exercises.

CDE forms look and feel like a typical spreadsheet.  They may be laid out in many different configurations.  Cells may contain labels, dates, functions or data from parameters, calculated variables or text parameters.  The data displayed in a CDE form could also be shown as reference information only.  

In this section we will learn how to access Custom Data Entry forms for data entry, enter data in a CDE form, open a different CDE form and review data for different days and some of the features of CDE.

Lesson 2.2.1: Opening a CDE form and Enter Data

The most basic style of CDE form is a Daily Data Entry form.  This form shows a number of variables presented in a user-defined order.  
Step 1: Open a CDE

1. Select the Data Manager, Custom Data Entry for a list of available CDE forms.  
2. Double-click on the “Daily Data Entry” form name.
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The selected form will open.  If Auto Advance is on, the selected cell will be the first data entry point on the form.  Auto Advance is optionally set when the form is designed and instructs the form to advance to the next entry cell (cells with white background) when Enter is pressed.  The Start Date of a CDE form opened in this fashion is yesterday.  We assume that in most cases today’s data does not yet exist.  

3. For the purposes of this lesson, change the Start Date to the 10th of the current month (or a date beyond current date):
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Step 2: Enter Data into the CDE

Type the value to begin entering data for the selected day (April 10th  in this case).  Press the [Enter] key or use the mouse to move to another cell.  Data is automatically saved to the database when you leave the cell.  Pressing {Enter} will move to the next data entry cell automatically if the Auto Advance feature is turned on.  The direction it will move is determined by the Enter Key Action setting.  

1. Enter the following data for the current date:

· 3100 Flow Rate 3am

3.3

· 3111 Runtime 4am

114.0

· 3142 Lab Turbidity 4am

0.113

· 3191 Loss of Head 3am

.72

· 3191 Loss of Head 4am

.66

· 3200 Flow Rate 4am

3.1
2. Click the [image: image32.png]Save



 button near the top of the window to save the changes (entries) to the database.  
3. Exit. Click the [image: image33.png]


 in the upper right-hand corner.
Lesson 2.2.2: Opening a Different CDE Form and Review Data
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Open a different Custom Data Entry form from the current CDE : 
1. Select the File, Open menu or click on the Open button - [image: image34.png]


.  
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Double Click on the name of the form you wish to open 






3. Open the “Weekly Lab Report” form.  Use the Date Selector to set the 1st day of the 7 day range that will be displayed.  Data is displayed to review and edit 

Lesson 2.2.3: Other CDE Features
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The Custom Data Entry window functions:

[image: image423.png]R

© ToskEnabed € Task it

L a—
Ao, it st s o e PN









The different sections of the Status bar at the bottom of the form.
Lab 2.3: Running Reports 
In this lab we will learn how to Output/Preview Spread Reports using Report Pac.
Step 1: Use spread reports

Select Report Pac, Spread Reports from the main menu.  
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Step 2: Choose your report
[image: image424.png]


Choose “CT Combined Filter EFF Turbidity Report” by clicking on it in the list of reports.
    
NOTE:  You can choose more than one report to output at a time.  Click on one report and use [CTRL-Click] to click on each additional report.  You can also use [Shift-Click] to select a range of reports.

Step 3: Choose where the output should go


Step 4: Set the report dates
Set the Report Dates using the date scroller  [image: image37.png]<| Jan2003 | >



.  Click [image: image38.png]


 and the report will be previewed to the screen.
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From the preview window, you can:

Print the page [image: image40.png](Eyprint Page|



 or the entire report [image: image41.png]& Print Al



.

Change the report dates using the Date Scroller  [image: image42.png]<| Jan2003 | >



.

 
Step 5: Exit the preview window
To Exit the form, use the windows close button  [image: image43.png]


.

Lab 2.4: Using the Hach Built-in Reports

There are a number of built-in reports for a quick look at data without designing a new report.  New built-in reports are constantly being added. Go to Report Pac, Spread Reports for the most current list.   

To use a built-in WIMS report:

1. Go to Report Pac, Spread Reports 
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2. The built-in reports will be listed at the bottom and always start with "Hach".
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3. Click on the report (or reports) you want to output.  The built-in reports function just like user designed reports.  Depending on the report selected, you will be prompted for the variables/username for the report. 

For example the Hach Daily report will prompt you to select up to 9 variables using the Variable Browser for the report.
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NOTES:

· The built-in reports are placed in the Default Report Group.  Use the Report Group Manager to move the built-in reports to different groups.  
· You CANNOT delete built-in reports.  You can move them to a group that only Super users have access to (i.e. create a report group for Super users only).  This will "hide" the reports from all users other than Super users.

· You CANNOT customize or design a built-in report.  However, you can use the built-in Spread Report Templates to create a copy of the report and customize the copy using Spread Design.

EXAMPLES: Go to Spread Report Output to see all reports
Hach Basic Statistics Report (multiple variables)

Displays basic statistics (Average, Min, Max, Total, and count) for up to 40 variables for any date range:
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Hach Full Statistics Report

Displays 16 different statistics for up to 10 variables for any date range:
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Hach Daily Report 
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Displays daily values (or daily average for daily detail variables) and Min, Max, Sum, and Average for any date range for up to 9 variables: 
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Hach Variable Two Year Data Report

Displays daily values (or daily average for daily detail variables) for 2 years (broken down by month) for a single variable:
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Hach Variables with no data Report  

Displays a list of variables that have no data in the date range of the report.
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Hach User Activity Report

Displays for a specified user, the number of logins, last time user logged into facility, number of data points entered/edited/deleted. 

Lab 2.5: Running Graphs

WIMS provides extensive graphing capability.  In the following sections we will cover how to quickly trend data and display existing graphs.  
Lesson 2.5.1: Quick Trend Graphs

Quick trend graph allows you to view a simple trend of a single variable.  

A quick trend graph can be displayed by: 
1. Using Info button on the Variable Browser  (Data Manager, Edit/View Variables, click [image: image51.png]
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· From a Quick Trend Dashboard Button 

· From the Info button, Trend 1000 Most Recent option in Variable Setup.
· From Monthly Data Entry, right click and choose the Quick Trend Chart Option.
 Using a Quick Trend
1. Change the graph dates:

· Use the date pull downs to set Start and End Date or use the Date Picker
· Click Refresh
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2. Zoom in on data

· Click and drag on graph to zoom in on that area.  
· Use the scroll bar at the bottom to scroll thru the graph
· Right Click, and choose Undo Zoom to zoom back out.
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Lesson 2.5.2: Multi Graph Output
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To view or print previously designed Time Series or Correlation graphs:
a) Select Graph Pac, Multiple Output
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2. Chose the saved graphs to be viewed and set the date range. 
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Hint:  If you have a series of graphs you need to run on a routine basis, use the Save Settings button.  With the settings saved, your WIMS dashboard can launch the graphs from a button so you do not need to choose the graphs and layout each time.  When choosing Landscape orientation check to see if  # of graphs per page meet your needs .
Section 3: System Administrator Training

NOTE: Specific dates used in text and examples are for illustration only.  Dates in your examples may be different. 
Lab 3.1: Variable Setup and Math Toolbox

In this section we will learn:

· About Variable setup and Math toolbox features

· To create a new parameter

· To insert a new variable

· To create a new calculation
· To use help to build formulas
To add variables into your facility, select System Setup, Edit/View Variables.  
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Use the Variable Edit form to enter, add, change, and delete variables and their equations.  The variable number (Var #) is the key field in identifying variables.  The variable list is stored in variable number order.  
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Var #: The numeric variable identification.  Variable numbers don't need to be consecutive.  Variables are referenced by number when using many WIMS functions.  Typically, variables are displayed in Variable Number order.  Click [image: image58.png]


 to see entire list
Name: The textual description of the variable (required) and can be up to 40 characters long. Use variables names that are descriptive of the process or meter producing the values.

Units: An optional field representing the units of measure associated with the data entered for a variable (e.g. MGD for Influent Flow) and is limited to 10 characters.  A pull down box allows selection of units or units can be typed in.  

Track Every: Sets how often data is to be tracked for the variable.

Type: Defines the variable as an input parameter or a calculation.  When Calculated is selected the Equation tab is activated.
Description: An optional field that further describes the variable. This field is recommended if there could be any ambiguity in the meaning of the variable name (helpful for training new personnel and for review of the variable list and calculations). 
Short Name: An abbreviated variable name used during data entry (Data Manager) and for column headings on several reports.  The heading (AKA Short Name) can be up to 20 characters long.  NOTE: The Short Name field may optionally be hidden using the Admin Console, Display Variable short name in variable setup General Setting.  The setting is system wide (set for all  users and all facility databases)
Decimal Places: Maximum number of decimal places allowed when entering data for this variable.  Also, sets the default number of decimal places that will be displayed in reports.
Location: The location or sampling point of the variable.  See Location Setup to add Locations to the pull down list.
Storet Code: The EPA Storet code for the variable.  Use the [image: image59.png]


 button to browse a list of Storet Codes.  

Entry Min: Traps data entry errors.  If a number is entered in the data manager that is below Entry Min, a warning message will be displayed.  

Entry Max: Traps data entry errors.  If a number is entered in the data manager that is above the Entry Max, a warning message will be displayed.  

Rollover Check: Traps data entry errors. If checked, values will be checked for rollover when entering data.  For example, if you enter 8 and the previous value is 9994 you will be asked for confirmation that the meter rolled over.

LIMITS
Limit Name: The short name for the Limit.  The pull down list provides a list of common limit names.  You do not have to pick from the list, you can type in whatever name you like.  However, choosing from the list allows WIMS to default other values on this form. When entering data (e.g. using a monthly or custom data entry form) the DMIN and DMAX limits are checked and a warning limit is displayed if the limits are crossed

Start date: The start date for the Limit. 

End Date: The end date for the limit
Description: A description for the limit that further describes the limit. 

Current Limit: The comparison to use to determine if there is a violation.  

Grouping: Used to set which dates to calculate the stat for.  The calculated stat is then compared to the value with the stat field to calculate a value to compare to the Value.  If the condition is true, it is a violation.
Lesson 3.1.1: Creating a new parameter

This lesson takes you through adding a new parameter (Raw Water Iron) to the database.  First we need to plan where to place the new variable in the list.  
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Step 1: Open Variable Viewer

1. Click System Setup, Edit/View Variables


2. [image: image433.png]) Generic SCADA CSV Files Direct Interface Setup
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Click the browse variable button [image: image60.png]
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3. Scroll down to Raw Water Place the new variable after Raw Water Magnesium 1245 


Return to Variable Edit, click [image: image61.png]Qok









Step 2: Creating a New Variable

1. In Variable Edit, click New:
  [image: image62.png]



Add new will create a new blank variable at the end of the list.  In this case it created variable 9547.  We want to leave some space between the last variable and this newly created variable.  

2. We are adding the variable Raw Water Iron. Enter the following information:

· Name:
Raw Water Iron

· Units
mg/L

· Track every
Day


· Variable Type
Parameter

· Decimal Places:
2

· Location:
Choose “Raw Water” from the pull down.

· Storet Code:
01045

3. Click the Change VarNum button:  [image: image63.png]& vers]




4. You will be prompted for the new variable number.  Enter 1245 as shown below:

5. Click OK and the VarNum will be changed.  
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Data is automatically saved.  In the next lesson we will calculate the Eff TKN Loading.  
6. Click [image: image65.png]& Exi]



 or stay here to start the next lesson. 
Copying a block of variables to the database and managing a new calculated parameter (EFF COD Loading).
Step 1: Copy a Block of Variables
1. If not already open, Open Edit/View Variables. 

2. Click the Variable Browser button [image: image66.png]


, select City under the Location Tab. Scroll to the bottom of the well sites to V7339 – Colorado Acre Ft.  Double-click V7339 or click OK
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3. Place new variables at V7400 and copy V7320 to V7339.  To copy the variables, click  [image: image68.png]B Copy|



 and fill out the form as follows:

a. Set First Variable to be copied to 7320 Colorado Current Hours Read

b. Set Last Variable to be copied to 7339 Colorado Acre Ft

c. Set Location to copy variables to 7400.  
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Click OK. 


























Step 2: Enter New Variable Information and Formulas
a) [image: image436.png][ Options | UserDefined | MDLRules | | AddiionalInfo_ |

Desoipion | Uit | GpionaPim | auaiyConid |

==

COFF @ InefaceTo [ Hsoion ] DtaAprovalLevel ToWite With

Hep| O BemdSawe] ENTERED
TAG Statistic_ Scale Factor
[BIT_INF_FH 7 [[avERsGE =

Start Time Stop Time Filter

& Same Day as Start

0000 = (hemm) | [2353 = (nhimm)

 Day After Start

Filter Data
Colect data wher:
Node:Tag Field

LowRange [None
High Range [None
Deadband [0

2l



Edit the newly created variables to reflect that they are for the Peggy Rd Well as follows:  

a. Variable 7400

b. Name:  Peggy Current Hours Read

c. Track Every: Day

d. Type: parameter

e. Decimal Places: 0

f. Location: City

b) Click [image: image69.png]» Next



 to move to V7403.  Edit as follows:

g. Name:  Peggy Hours

h. Units: Hrs

i. Track Every: Day
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Type: Calculated

k. Decimal: 0

l. Location: City

c)  Enter the formula (equation) to calculate the load. Click on the Equation Tab to display formula entry.  This variable calculates the actual hours run based on an accumulating runtime meter which is read about once a week.
 

a. Equation ADIF(V7400)
b. Click Check Equation
c. Click Exit.  [image: image70.png]& el





 
	
V7405

Name:

Peggy Current Electric Read

Heading:
Peg C-Electric
	V7408

Name:

Peggy Electric Usage

Heading:
Peg Electric

Equation:
ADIF(V7405)

	V7410

Name:

Peggy Current Flow Read

Heading:
Peg C-Flow
	V7413

Name:

Peggy Flow Total

Heading:
Peg Flow

Equation:
ADIF(V7410)/1000

	V7413

Name:

Peggy Acre Ft

Heading:
Peg AFeet

Equation:
V7413*3.06889
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HINT:  When entering equations use the [image: image71.png]


 button on the Equation tab to browse for variables to insert into the equation.

Step 3: Using the Help File
WIMS contains over 100 functions that allow you to calculate all types of equations.  
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Press F1 to display help 

2. Browse to Function Reference, Math Toolbox Functions: for the list of available functions.
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The Math Toolbox help will be displayed.  The topic will display all functions that are available in WIMS and how to use them.  Click on a function to view the help topic.
Setting up Data Qualifiers
Hach WIMS allows the entry of <, >, and ND to signify a less than, greater than, or non-detect value.  These values are typically derived from a laboratory test that was above or below the Method Detection Limit (MDL, aka Minimum Detection Limit).  Additional allowable symbols may also be set up using Symbol Setup.  In order for a variable to accept the special characters, the “Allow the use of <,>, and ND Entries” field must be checked in Variable Setup.  The question is: What value should be used in summary statistics, calculations, etc.  when a special character is entered?  WIMS stores both the entered value (ie <2, ND, >100, etc.) and the numeric value (2,0,100,etc.) in the database.  In Variable Setup, the MDL Rule sets what value should be used.  
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FIELDS:
Symbol: The data qualifier from the list of data qualifiers (symbols) in Symbol Setup.  

Numeric Value to Use: Sets what value to use when the Symbol is entered.  

	Entered Value
	The numeric portion of the entered result is used, i.e. <2 is 2, <10,000 is 10000.

	Zero
	0 is used, i.e. <2 is 0, <10,000 is zero.

	1/2 Entered Value
	<2 is 1, <10,000 is 5,000.  Cannot be used with symbols that do not have a numeric portion (i.e. ND)

	Constant
	Uses the setting field as a constant numeric value.  If setting set to 1,000, >50 is 1,000, >1200 is 1,000...

	Twice Entered Value
	>2 is 4, >100 is 200.

	% of Entered Value
	Uses the setting field to calculate a % of the numeric portion entered.  If setting is 10, then <100 is 10, <1500 is 150...


Setting: Is used with Constant and % of Entered value to determine numeric value to use.
EXAMPLES:
Calculate a variable that allows data qualifiers
Calculated variables that refer to variables with a < use the value specified by the Numeric Value if < Entered field (i.e. the numeric value) is set.  
1. Set up a new variable – POE Gold with VAR # 5071 and set the MDL rules:
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2. Set up a “calculated variable” POE Gold Weekly Average – POE Gold Wkly Avg – Var # 5072.  
 POE Gold Wkly Avg (V5072=WAVG7(V3142) with a 7 day week. Set Number of decimals to 4.
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3. Create a monthly data entry sheet and enter the following data and calculate
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	5071
	Notes

	<.0005
	<.0005  is treated as a .0005 (Entered Value) in the calculation

	ND
	ND is treated as a 0 in the calculation

	
	Entries with no symbol are treated as the value:  3 * 5 * 8.34 = 125.1

	>.0006
	>.0006 is treated as .0006(Entered Value)


Calculations use the value specified in the “Numeric Value to use” when a <, >, or ND is entered. 
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Calculate a value that displays the symbol if the inputs contain symbols
Calculated variables can be setup to Cascade Symbols.  On the MDL rules tab, if the variable is calculated it will prompt if you want to cascade the symbol when calculating.  Also, you will be prompted if you want to cascade all symbols or cascade just the most frequent symbol.  The following table illustrates the different techniques.   (Note: V1, V2, and V3 are setup to Allow Symbol and use Entered Value for '<','>', and 'E' symbols.  ND is setup as Zero.)

V4 = MVAVG(V1,V2,V3) with Cascade Symbol OFF.

V5 = MVAVG(V1,V2,V3) with Cascade Symbol On with Most Frequent Symbol.

V6 = MVAVG(V1,V2,V3) with Cascade Symbol On with All Symbols.
	V1
	V2
	V3
	V4 (Cascade Off)
	V6 (On - Most Frequent)
	V5 (On - All)

	3
	<2
	<4
	3
	<3
	<3

	3
	ND
	4
	3.5
	ND3.5
	ND3.5

	<3
	E5
	<4
	4
	<4
	<E4

	1
	2
	3
	2
	2
	2


See Also: 
For handling of symbols in reports for averages, etc. see GAVGZ or STATZ.

To override the Numeric Value to use setting in a specific calculation, see MDLV.

Lesson 3.1.2: Setting Entry Limits

The Entry Limits are used to warn the user when entries are outside the normal range.   Entry Limits are set for each Variable on the Variable Edit, Description Tab form.  If an entry is made outside the specified range, a message is displayed:
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The pH was 10.2, WIMS warns the user that the value is over the Entry Limit..  

The Calculate button suggests Entry Limits based on historical data for the variable (it calculates the mean +- 3 standard deviations).  Use the Calculate button after you have a sufficient amount of data.  

Rollover Check - Traps data entry errors on totalizers (such as odometers, runtime meters, flow totalizers, etc.). If checked, values will be checked for rollover when entering data.  For example, if you enter 8 and the previous value is 9994 you will be asked for confirmation that the meter rolled over.
NOTES: 

· If entries are accepted outside the entry range, they will be displayed with a green background and italicized text in Data Entry Forms such as Monthly Data Entry and Custom Data Entry Forms.  [image: image80.png]102




· [image: image441.png]


Use the Compliance Engine to log values outside the Entry Limits

Lesson 3.1.3: Setting up regulatory limits

Limits may be imposed historically on a variable over various time periods.  Limits are used to detect violations and to count violations.  

In the following lesson we will setup the following Chlorine Residual limits:
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Daily Limit:  3.5 mg/L

Monthly Average Concentration Limit: 4 mg/L

1. Go to System Setup, Edit/View Variables

2. Bring up the Airport Average Chlorine Residual  variable – V8605
3. [image: image443.png]Collector:  US Geological Survey

Save  Cancel




Click on the Limits tab and click New






4.  Enter the Limit Information as follows for the daily limit of 3.5 mg/L and click OK:
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5. Click New again to setup the Monthly Average Limit.  Choose MMAX and notice that the Grouping and Stat are defaulted for you.  Enter your limit value of 4.0 and click OK









Once the limit is set up, WIMS uses the limits in a variety of ways:
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Entering data with Daily Limits
Open the Dist Online Chlorine Review form in Monthly Data Entry.  Data Manager/Monthly Data Entry and click Open 
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Move to the Airport Average Chlorine Residual column and enter 6.  Notice that WIMS warns you and the result is bolded on the form: 
Showing the number of violations in a Spread Report

Open Design>Spread Reports
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Click on cell B4 and go to Locate>Daily Values

1. Choose  Airport Average Chlorine Residual 

2. Set Display Values to 15.  

3. Check Print Data only when it occurs

4. Check Place Date beside Data
Click on cell E4

Go to Locate>Number of Violations

1. Choose Airport Average Chlorine Residual
2. Check the Count boxes on both limits
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3. Click OK.
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The Locate number of violations places the following formula (use Help-F1 to better understand the VIOL formula):

=VIOL(8505,"V","None","DMAX")+VIOL(8605,"M","AVG","MMAX")
Move to current month and enter the following values.
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Use the built-in Hach Compliance Status Report to display the violations:

Go to Report Pac, Spread Reports

Choose the Hach Compliance Status Report

Set the Report Dates
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NOTE: The limit lines can be placed on graphs.  See Lab 3.6 Graphs for example.  

Lesson 3.1.4: Cross-referencing SCADA variables

The following examples show how to set up WIMS variables to cross reference to a specific tag in a SCADA system.  After a SCADA interface has been installed and configured to connect to your SCADA system you must tell the interface which data points to bring across and how to summarize that data.  To cross reference your variables:
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Go to System Setup>Edit/View Variables.















2. Click on the Interface Tab

3. Select “Interface To” and choose the system to pull data from.  NOTE:  The list of available interfaces is setup during the installation of an interface.  See Lab 4.7 Using Interfaces or your interface manual for information on installation and configuration of interfaces.

Example 1: Average DO for the day
To capture the average Chlorine Residual for the day; this is a sample of our data and how to setup the WIMS variable: 
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The 24 data points total 54.2. Our average for the day will be 2.258333 (depending on number of decimal places set for this variable). The value is stored on the start day and time. 

Example 2: Average Chlorine Residual  from 8 AM to 8 AM the next day
In this example we need the average DO but we want to start and end the readings at 8 AM. Here is a sample of data and how to set up the variable in WIMS. 
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The number of data points is 24 again, and the total is 54.2, so our average will be the same as example 1 = 2.258333. Notice we selected Day After Start. This tells WIMS that the Stop Time is the day after the Start Time. The value is always stored on the start day and time. 

If you set these times and left Same Day as Start, WIMS would think you wanted data from 7:59AM to 8:00AM of the same day – what is the average for one minute of the day – which is wrong! 

By setting Day After Start, WIMS knows you want the average from 8 AM on one day to 7:59 AM the next day. 

Example 3: Total flow from a daily totalizer that resets at midnight.
“Total flow” can mean so many things, so it is important to know what flow you are talking about. Think of a totalizer as an odometer – always counting up.  Now some totalizer meters always reset at midnight. This is how to set up a WIMS variable to handle a flow totalizer that resets at midnight. 
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The value we will capture will be the highest number by midnight, which is 1368. Note: Why don’t we use last? In the case above, LAST would work, but if the SCADA system is logging data a fraction of a minute and the meter resets before 23:59 – you could end up with a reading of zero or something totally wrong! 

Example 4: Total flow from a totalizer that doesn’t reset every day. (DIFF)
When a totalizer resets, but not every day, Use the DIFF statistic. This statistic calculates the difference between the first value and the last value for the period requested (e.g. if the variable is defined as an hourly variable, DIFF will get the first and last values for each hour and subtract them). 
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In our example, we have a daily variable that uses the default start and stop times. The midnight reading is 925 and the 23:59 reading is 40. The meter rolled over at 15:00 or 3 PM. The meter is approaching 999 which is the assumed rollover point in this example. 

The interface will subtract the last value from the first, and if the result is negative then we have a rollover. By using logarithmic functions, we can determine that the rollover is 1000 and subtract the sum of the first and last readings. If there is no rollover, the interface returns the difference between the last value and the first value. 

In our case, the difference of the last and first values is -885. The interface determines 1000 as the rollover by taking 10 to the power of the log of the number rounded up. Log of 885 is 2.9, rounded up to 3 and 10 to the power of 3 = 1000. It then subtracts the rollover from the first reading and then adds the last reading = 1000 – 925 + 40, giving us 115. 

In our data we stepped the value by 5 every time, so 5 times 23 data point changes = 115. 


Example 5: Total flow from an instantaneous flow meter reading
The previous examples showed totalizers as being like odometers; the next type of flow is like a speedometer and is called an instantaneous flow meter. This is a meter that might show how many gallons per minute (GPM) are flowing through a pipe.  We need to convert gallons per minute to millions of gallons per day (MGD). There are 1440 minutes in a day and we want one millionth of that number. So our Scale Factor will be 1440 / 1,000,000 or 0.00144. The following is some sample data and a screen of a WIMS variable for this purpose:
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The average of GPM coming through the pipe is 333. When we convert the average by our Scale Factor of .00144 we get 0.47952 MGD. This is almost one half of one million gallons per day.

Why use Average instead of Total?  We could have totaled the numbers and divided by the number of data points. In this case our total would be 7992. In order to calculate MGD, WIMS would have to know how many data points were used to total 7992, because we still need the average flow. WIMS does not know this number and the number of data points could change from minutely to secondly values. 

Example 6: Total flow from a tag that holds yesterdays (previous) total flow.
This peculiar tag holds the total flow from yesterday (or “previous” day). Typically it changes right after midnight to hold the new previous day. This is our sample data and how we set it up in WIMS:
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We see our value stays the same until after midnight when it changes to 632. We span over two days by setting the Start Time to 11 PM, Stop Time to 3 AM and select Day After Start. The value 632 will be stored at the start day and time. Why did we span the time so far apart? Daylight Savings Time will affect your data twice a year so the cushion will mean we won’t have to worry about that.

Example 7: Get the average turbidity when BACKEB00 = 1.
The following examples use Filter and Filter Data. The difference is Filter will filter data value for a tag based on its own value. Filter Data will filter data value for a tag based on the value of a different tag.

The Filter controls are on the far right side of the Interface tab and the Filter Data controls are on the bottom of the Interface tab. 

This first example shows how to filter turbidity values when BACKEB00 equals a value of 1. BACKEB00 could be analog data that changes constantly throughout the day or it can be a digital reading that just switches from 0 to 1 like when a valve opens and closes.
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Notice that the average for the range of data we have selected only uses the values highlighted. BACKEB00 must be exactly one (1) because that is what we specified in the Filter Data.

Lab 3.2: Area and Location Setup
Your variable list can be organized in a tree view.  Areas are the top level, locations are assigned to Areas, and variables are assigned to locations.  For example, you may want to organize your list at the top level for the WTP, Filters, and Distribution Monitoring – these would be your Areas.  Under the WTP, you would have the sample locations/processes – Raw water, Blender, Settled water, etc. 

Setup Areas:

1. System Setup>System Tables, This Facility, Area Setup:
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2. Click [image: image98.png]


 and enter the Area Name and Description:
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3. Repeat for Filters and Dist.  
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Assign Locations to Areas:

1. Go to System Setup>Location Setup
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2. Set Area to WWTP:
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3. Click [image: image103.png]


 and assign Sample Point to WWTP.  

4. Repeat for all locations.  Your variable browser should now look like this:
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 Creating new locations:

1. Select System Setup>Location Setup
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Click New:  
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Enter “Well #4” for the Well name. 
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4. Fill in the form as shown: Select the area “WTP” building the tree view in the variable browser
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You can list the locations in process order or any other order you find logical.  Click Order:  [image: image105.png][ Order|



. The location list is displayed in user defined order (not alphabetical).  

Click on a row (Disinfection) and use the arrows to move the row up and down. Move Disinfection below Chemical






6. Click Exit: [image: image106.png]& il




7. You will be prompted to Save Changes to the order, 

click Yes:  [image: image107.png]



8. The locations will now appear in your order on the 

Variable Browser:



Exercise – Area, Location, Variable Setup:
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We have a new Water Plant.  Create an area, the locations for the plant, and variables for the plant.

1. Create an Area called Water Plant.  Go to System Setup,  System Tables, This Facility, Area Setup.

2. Create the following Locations and assign to the Water Plant Area:

· Raw Water

· Filters

· Finished Water
3. Create the following variables:

	Name
	Units
	Track Every
	Notes

	Raw Water Pumpage
	MGD
	Day
	

	Raw Water pH
	SU
	Hour
	

	Raw Water Turbidity
	NTU
	Hour
	

	Raw Water Color
	Obs
	Shift
	

	Filter #1 Turb
	NTU
	15 Min
	

	Filter #2 Turb
	NTU
	15 Min
	

	CFE Turb
	NTU
	Hour
	

	Finished Water  Chlorine Residual
	mg/L
	Hour
	

	Finished Water Temp
	Deg C
	Hour
	

	Finished Water pH
	SU
	Hour
	

	CT Required
	Req
	Hour
	Calculate based on Free Chlorine as Disinfectant, 3 log inactivation

	
	
	
	


Lab 3.3: Designing Spread Reports
Lesson 3.3.1: Designing a Manual Spread Report 
Step 1: Getting familiar with the Spread Report Editor

1. [image: image459.png]


From the main menu select Design, Spread Reports.  












Spread Report Generator allows you to use the familiar spreadsheet interface to build a report.  You can locate variable data into the spreadsheet cells and use spreadsheet formulas to calculate and summarize the data.  

Step 2: Start the Report

First type the title of the report.  Move to a cell and type.  If the text does not fit in the cell, text will wrap into the next cell providing that the next cell is empty.

1. Move to Cell E2 and type: “Raw vs Finished Water”
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Click on Cell B7:
3. In the menu select:  Locate, Daily Values.  The Locate Variable Formula window opens.
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4. Select Variable “1003-Raw Water Flow” 
5. Check Place Date beside Data and click OK.  

Data will be placed on the report for the currently selected month (09/29/14):

Step 3: Change Report Dates

1. Use the Date Scroller to move to a month with data.  Use the [image: image110.png]


 button, or click on the displayed date [image: image111.png]Feb 2009



 button to pick the month from a list.  
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The data from the chosen month will now be on the report.
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Step 4: Locate other variables
Locate several variables.  Referring to the list below, move to the cell indicated and select Locate, Daily Values.  Choose the variable and click OK.  


	Cell:
D7

Variable:
1024 - Raw Water Turbidity Average
	Cell:
G7

Variable:
5201 - POE Hardness

	Cell:
E7

Variable:
1091 - Raw Water Hardness
	Cell:
H7

Variable:
5241 – POE Nitrate

	Cell:
F7

Variable:
5001 -  POE Total Flow
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Step 5: Printing and Page Layout Settings

1. To view and edit the printing options select Sheets, Properties:
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2. Set the orientation to landscape.  NOTE: The page Orientation MUST be set here, using the printer settings will not work
3. Click OK.
Step 6: Save the Report and Exit

1. Select File, Save:
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2. Enter “Raw vs Finished Water” and click OK. 

3. Select File, Exit to exit Spread Reports.

You have just set up a simple report.  

To return to this report for editing, click on Design, Spread Reports.  Once Spread Report is open, go to the File menu and click on Open.  A list of reports will appear.  Select the report you want to work with. 
In the next steps, you will format the report and add summary statistics.  

Step 7: Place Summary Statistics

Now we will place the average and maximum at the bottom of the report.  
1. Move to Cell C39 and Select Locate, Monthly Summary and fill out the form as follows:

2. Change the Variable field to “1003- Raw Water Flow”

3. Click on the drop down arrow to select the “Average” statistic.
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Change the Locate Statistic for field to “1” month.

5. Click OK and the Monthly Average will be placed in the C39 cell.  

6.  Complete the report by locating the other summary statistics:

	Cell:
C40

Variable:
1003 – Raw Water Flow

Statistic:
Maximum

	Cell:
F40

Variable:
5002- POE Total Flow

Statistic:
Maximum


	Cell:
D39

Variable:
1024 – Raw Water Turbidity Average

Statistic
Average

	Cell:
G39

Variable:
5201- POE Hardness

Statistic:
Average


	Cell:
D40

Variable:
1024 – Raw Water Turbidity Average

Statistic:
Maximum

	Cell:
G40

Variable:
5201- POE Hardness 

Statistic:
Maximum


	Cell:
E39

Variable:
1091- Raw Water Hardness

Statistic:
Average

	Cell:
H39

Variable:
5241- POE Nitrate 

Statistic:
Average


	Cell:
E40

Variable:
1091- Raw Water Hardness

Statistic:
Maximum

	Cell:
H40

Variable:
5241- POE Nitrate

Statistic:
Maximum


	Cell:            F39

Variable:     5002- POE Total Flow

Statistic:      Average
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Step 8: Calculating Using Spreadsheet Formulas
Calculate the 7 day moving average for the raw water turbidity.

a. Insert a column between D and E by clicking anywhere in column E. Go to Edit, Insert Column
b. Click on E 13 and enter the following formula: =AVG(D7:D13). Increase decimal places to 2
c. Go to Edit and Copy Special. Highlight Cells E14 to E37, Edit and Paste Special. Enter 
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Step 9: Format and Borders

Change the font of the Title.  

1. Click on cell F2. Set to Bold 12. 





2. Add titles at the top of each column.  Move to Cell B6 and type “Date”. 
3. Enter the other titles and merge cells as shown in the figure below. Hint: Merging cells 
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To resize a column, move the mouse pointer between the columns.  The mouse pointer will change and you can then drag the mouse left to shrink the column or right to enlarge the column.  To adjust the row height, move the mouse pointer between the row's headers.  The mouse pointer will change and you can then drag the mouse (by clicking and holding the button) down to enlarge the row or up to shrink the row. 
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NOTE: To resize multiple columns at one time, select all the columns by clicking and dragging the mouse on the column headers.  With the columns selected, resize one of the selected columns and all the selected columns will be sized the same.  This method can also be used to resize multiple rows at one time.  
Preview the report before printing or saving. 
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Review
Exercise – Design Basic Summary Report

Design a spread report that shows the following statistics for four (4) quarters:

1. POE Chlorine Residual
a. Quarterly Minimum

b. Quarterly Maximum

c. Quarterly Average

d. Quarterly Total

Lesson 3.3.2: Using Spread Report Wizard

The Spread Wizard makes spreadsheet creation quick and easy.  In this section we will learn how reports can be generated quickly and easily using the Spread Wizard to generate and print a monthly summary of our data.
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STEP 1: Start the report

1. Go to the main menu; select Design, Spread Report.  
2. Select File, Wizard or click   [image: image118.png]








3. [image: image469.jpg]Title of Current Form
e Peste  Display exising Value or Formula Daily Commert Status Box Enter or Edt & dally comment

=loix|

Flo Edt Format Hip

e L i e e #
ow|caics |

65 Jraoh =0 B Tl oo [ 2]
o\ e o I Recaleuste ALL
Graph s o curr Coloultedt Variables  Recaicuite Clear Selected
OpenFie Selected Data Data Changes i celts)
Print Preview ‘Action Button the Form

Show sl caleutedt

(Data approval) Variables



The Wizard introduction form will appear.  When you are finished reading about the Wizard, click on the [image: image119.png]Hext >



button.  
4. A variety of reports that can be designed from here.  The Columnar report would have been an excellent tool to quickly set up our report from the last lesson. Select Summary from the list of report types and click [image: image120.png]Hext >



.  
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Enter a name for your report.  Type “BOD/TSS Totals Summary” and click [image: image121.png]Hext >



.

6. Select the data that will represent each month.  For this report we will choose the monthly Average.  Click [image: image122.png]Hext >



.
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Select the number of months to display in this report.  For this report we will use 12 months.  Click [image: image123.png]Hext >



.

8. Selecting the variables:  

· Click on the variables to select them for the report
· Press and hold the [Ctrl] key to select multiple variables

· Click on the single green arrow to move variables to the “Selected Vars” area (double green arrows move all variables)
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· Click [image: image126.png]Hext >



.




9. Select the column headings we want to appear in the report.  Select Variable Name and Units as displayed in the figure below.  Click [image: image127.png]Hext >



.
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10. Select the summary statistics we want in the report.  Select all except the geometric mean.  Click [image: image128.png]Hext >



:
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Choose the style/format from the options available. To preview a format, click on it and an example will be shown on the left.  Click [image: image129.png]Hext >



:

12. The report is complete.  Click [image: image130.png]


 to create the report.  You may now customize the report as you wish. 
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You have now successfully created spread reports with both the Spread Wizard and manually with the Spread designer. 

Lesson 3.3.3: Spread Report Advanced Topics

Understanding Offset in Equations

Grouping functions return summary values for a variable for the specified Group Date Range.  The VarNum parameter sets the variable to be used.  Use Locate, Group/Yearly/Monthly Summary.  Most Grouping Functions have two forms, one for normal data placement and one for use with MDL type variables.  For example, GAVG places the raw data, GAVGZ places the data along with the <,>, or ND as appropriate.
GAVG(VarNum,Offset,Grouping)
VarNum
Sets the variable for the calculation.

Offset
The offset combined with the Grouping parameter sets the date range for the statistic.  Set the number of Groups (set by the Grouping Parameter) to be added to set the dates.  See examples below.
Grouping
Used to set which dates to calculate the stat for.  Valid Settings are:
“D”
Daily (to summarize Daily Detail Variables)

“M”
Monthly

“Q”
Quarterly
"SA"
Semi-Annual
"S"
Season (Winter, Spring, Summer, Fall)
“Y”
Yearly
In the example below, the report dates are set to Jan 1, 2006 to Jan 31,2006:

Equation

Description









=GAVG(1,1,”M”)
Returns the monthly (“M”) average for the first month (January) of the report.

=GAVG(1,2,”M”)
Returns the monthly (“M”) average for the second month, as specified by the offset of 2, (February) of the report.

=GAVG(1,13,”M”)
Returns the monthly (“M”) average for January 2007, as specified by the offset of 13.

=GAVG(1,0,”M”)
Returns the monthly (“M”) average for December 2005, as specified by the offset of 0.

=GAVG(1,-1,”M”)
Returns the monthly (“M”) average for November 2005, as specified by the offset of -1.

=GAVG(1,2,”Y”)
Returns the Yearly (“Y”) average for 2007, as specified by the offset of 2.

The Offset and the Grouping can be used to get data in the future and the past.  

The following table shows the offset to use for common tasks.  In the table the report dates are set to Jan 1, 2006 to Jan 31,2006.

Monthly Grouping “M”

	Offset
	Description
	Month 

(based on 1/1/06-1/31/06 report dates)

	-2
	Two Years Ago
	Jan 2004

	-11
	One year ago
	Jan 2005

	-10
	
	Feb 2005

	-9
	
	Mar 2005

	-8
	
	Apr 2005

	-7
	
	May 2005

	-6
	
	June 2005

	-5
	
	July 2005

	-4
	
	Aug 2005

	-3
	
	Sept 2005

	-2
	Three Months ago
	Oct 2005

	-1
	Two Months ago
	Nov 2005

	0
	Last Month
	Dec 2005

	1
	This month
	Jan 2006

	2
	Next Month
	Feb 2006

	3
	Two months ahead
	Mar 2006

	13
	One year ahead
	Jan 2007

	25
	Two years ahead
	Jan 2008


Yearly Grouping “Y”

	Offset
	Description
	Year

(based on 1/1/06-1/31/06 report dates)

	-1
	Two Years Ago
	2004

	0
	One year ago
	2005

	1
	This Year
	2006

	2
	Next Year
	2007


Apply the G functions to design a report.

Designing a Flow Study Report

In this section we will use the G summary functions to design a report that displays the daily flows for a month along with the flow average and total for this month, last month, the same month one year ago, and the same month two years ago.
Step 1: Start the report

1. Go to the main menu; select Design, Spread Report.  
2. Click on cell C3 and select to Locate, Monthly Summary. 
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3.  Fill out the form as shown and click OK:
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4. Type in the following text to identify each stat as shown: 
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Edit the formulas in C4, C5 and C6 to display the correct stat. 
5.  Click on cell C4 and the formula will be displayed in the formula bar: 

=GAVG(1003,2,”M”)

6. The offset is set to 2.  To display Last Months average edit the offset to “0”:



=GAVG(1003,0,”M”)

The value in C4 will now display last month’s average. 
7.  Edit C5 and C6 as shown:

C5
  =GAVG(1003,-11,”M”)

C6
  =GAVG(1003,-2,”M”)

8. Go to File, Save and save the report as “Variable Summary Report”.  
9. Add variable information to allow you to run the report for any variable.  
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First, drag cells B3:C6 to B6 to make room for the heading.  

11. Enter the text in cells B2, B3, and B4 as shown:
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12. Type 1003 in cell C2.
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Click on cell C3 and go to Locate, Variable Info



















14. Click OK and the variable Name “Raw Water Flow” will be located in Cell C3.

15. Click on C4 and go to Locate, Variable Info:  Choose Variable 1003 and Units for the Field and click OK.

Display the data and heading for any variable in the report.  
16. Click on cell C3 and the formula is displayed:

=VINFO(1,"Name")

17. Edit the formula to get the variable number from Cell C2:

=VINFO(C2,”Name”)

18. Edit the other formulas as follows:

C3:
=VINFO(C2,”Units”)

C5:
=GAVG(C2,1,"M")

C6:
=GAVG(C2,0,"M")

C7:
=GAVG(C2,-11,"M")

C8:
=GAVG(C2,-23,"M")
19. Change cell C2 to 5001and the report will now display data for variable 5001, Pump Total Flow.  
20. Save the report, now you have a report to analyze any variable.

Other Topics
· Sorting daily data

· Locating historical daily data

· Locating Daily Detail Data

· Using Locate Filtered Dates

· Rotating text, merge cells, and graphics.

· Report Group Manger

· Using Conditional Formatting
· Locate Time Series Graphs in the Spread Report

Review 
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Exercise - Spread Report Design
Design a report that shows the 20 highest flow days and your key operating parameters on the high flow days for a date range.  HINT – Use the Spread Report Wizard
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Using the same report, show the lowest flow days.  HINT – Use Locate, Daily Values and Sort.

Show days where the Raw Water Flow is greater the 40 and the Raw Water Turbidity is greater than 4.  
Hint: Use Locate, Filtered dates.
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Lesson 3.3.4: Using Calculated Variables in Spread Reports
Example 1: Max Weekly Average:  
This is a two-step process. First we must calculate the weekly averages. Then find the maximum of those values.

For example, to calculate the max weekly average for variable 5001 POE Total Flow:

Step 1: Creating the Variable

1. Open up Edit/View Variable window. System Setup-> Edit/View Variable.

2. Copy V5001 to V5002 and change the variable type to Calculated.

Determine your week definition.  Most states define the week as Sunday through Saturday.  The question is what to do when the Sunday is in one month and the Saturday is in the next month.  WIMS has several options (see help topic Weekly Beginning and Ending Dates).  We will use week definition 7, Sunday thru Saturday where the Weekly Average is placed at the end of the week (Saturday). 

3. Enter the equation WAVG7(C5001) where WAVG is the formula for weekly average and the 7 determines the week definition.  

4. Change the variable name to “POE Total Flow Weekly Avg”
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5. Calculate the data:  Go to Data Manager, Monthly Data Entry, Point of Entry Review and insert V5002 to the right of V5001 POE Total Flow.  Press the Calc button:
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Step 2: Creating the Spread Report

Create a spread report to display the calculated variable that we just created and to report the max weekly average. 
1. Design a new, blank spread report.

2. Click on cell G5 and Locate, Report Summary.  
3. Choose variable V5002, stat of Maximum and click OK.  You now have the max weekly average.

4. In C2 Locate, Daily Values for variable V5001, choose heading Name and Units on the Heading tab of the Advanced menu.  Also, check the “Place date beside data” with a date format of ddd, mmm dd on the Options tab.

5. In E2 Locate, Daily Values for variable V5002 with heading of Name and Units
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Example: Calculate flow based on flow meter

Use DDIF(Daily Difference with rollover function) to calculate flow based on a flow meter reading. Since meters rollover, a function must be used for this calculation that takes roll over into account. 

Step 1: Creating the Variables

1. First, create a meter reading variable. Go to System Setup->Edit/View Variables 
2. Copy Variable 1001 Raw Water Flow to a new variable numbered 1011.
3. Make sure the Type of the variable is Parameter. Rename the Variable “Raw Water Totalizer” Change the Maximum entry limit to 9999.
4. Copy Variable 1011 to a new variable numbered 1012 and change the name to “Calculated Flow”.
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Step 2: Setting up the Calculation
5. Go to the Equation tab for variable 1012 (Raw Water Totalizer). 

Variable 1011 is the raw meter reading entered every day at midnight.  Variable 1012 calculates the actual flow using DDIF in the equation tab. 
6. Enter the Equation DDIF(C1011) as shown. 
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Step 3: Setting up MDE to View Rollover
7. Data Manager-> Monthly Data Entry and double click “Raw Water Monthly Review.”

8. Insert a new column for variables 1011 and 1012. Right click->insert column.

9. Enter some data in the first few days of the month for variable 1011 as shown. 

On the 2nd row the DDIF handled the meter rollover. 4 = (10000 – 9999 + 3).

Review
Exercise – Run a report showing deleted and/or changed records for auditing:  Prior to running my monthly regulatory reports, I want to see all data that has been modified so I can review it.  

Lab 3.4: Designing Monthly Data Entry Forms 
Monthly Data Entry is used to enter data into WIMS.  This lab exercise demonstrates how to design a Monthly Data Entry Form:

Monthly Data Entry displays variables in a spreadsheet type layout for data entry and review.  Each column is a particular variable and each row represents a different day of the month.  The forms display one month at a time along with statistics for each variable at the bottom of each column.  Monthly Data Entry forms can be designed to display daily variables in any order.  

Lesson 3.4.1: Monthly Data Entry Designer
Step 1. Get into the Monthly Data Entry Designer:

· Click on Design, Monthly Data Entry Forms.
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From the Monthly Data Entry Design form create a new data entry screen or edit a previously created data entry screen.  When Monthly Data Entry Design opens it displays the design of the first form that was created. 
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Step 2: Add a new form
1. Click the New button.
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2. Enter “Peggy Well” into the Enter New Form Name input box. 
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GO- o scurt g R[B)6)pR) [0 sexcn ooge
Fle Edt View Favortes Toodks Hebp * $snogit B &
% Favortes | @ Hach IM Support Area 1 &- 2 @ - Page~ Safety~ Tods~ @

(0PS Systams s boe puchased by Hach Compary
Forkuther kot o1 PSSyt et s st hach o

Create New Support Area Account

A s bl s ol ot

Enst sttss
[T ———

Passwerd s chars )
Cotim Passucrs

YourFulame

——
—————

——————
—————

—

By clckng e buton oo, you s o
et of o500 e s gy

‘Supportinks:

oy Suppon Cases
At Produc s

Remow Product
Cemmee

KoowiedgaBase

[rs—
S




[image: image486.png]Your account was successfully created.

We itst sant an amail fo
youmame@systemsrus.com
in order to venty your email address.

Please check your email for a message from imsupport@hach com
and follow the instructions inside of the message

You cannot login until you verify your email address
by clicking on the link inside of the message we just emailed you.

NOTE: Some spam blocking software may have blocked the autogenerated email we
had sent you. If you believe that was the case, add iimsupport@hach. com to the
whitelist in your spam blocking software configuration and click here to resend the
‘email address verfication message.



The Enter Key Action list lets you pick what will happen when [Enter] is pressed on the keyboard.  Select “Down” to move to the next day (for the same variable) or “Across” to move to the next variable for the same day.  We will be entering data for one day, so choose “Across”.

































4. Choose the Heading:  

Check Variable Num, Variable Name and Units.  

5. Choose the variables: In the Variables tab, click on the [image: image143.png]4dd



 button.  In the Variable Browser box, click on V1 (Operator-In-Charge Shift 1).  Now type “74” in the body of the box to hop to V7400.  Click on V7400 which will highlight it. Then press [Shift] and click on V7419.  This will select all variables between 7400 and 7419.  
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NOTE:  You can also use [CTRL] Click to select or deselect individual variables


































6. Click [image: image144.png]


 to add the selected variables to the form.
7. Rearrange the variables so the Parameter Variables are the first columns and the calculations follow.  Delete any variables that you don’t need by highlighting  those variables and clicking once.  Go to the Remove tab, and click Yes to remove that variable. 
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8. Click and highlight V7405 in the Form Variables List then click the move up arrow, once. Move V7410 up as shown.  
[image: image146.png]4 Frst | @ prev| b vext| D tast| b new [ bx el Advanced Ext
FomName: [PeogyWell .| Change| ~Hesdng
Vaiible Num [~
Enty Goup [ Moy Daa Eny | VaissNans [0
ShortNeme [
Fom Type Edt Mode Dvenrte: © On C Of Uits ¥
@ Vaiable Storet r
Use Approval Level Color Scheme | T=oel [l
€ Locaton
Enter Key Acton |
Variables i
add [ FRemove | | Remaveal
Var# Var Name Units [Hea
7400 Peggy Current Rours Read s
7405 Colorado Current Electric Read Kutrs
7410 Cobrao Current Fow Read uc
7403 pegey Hours e
7408 Coborado Ekciric Usage Kutrs
7413 Cobrado Fiow Total uc
7418 Colorado Acre Pt Acre

SUPER (3/11/2010 322,58 4M) MDEID: 12





9. Click Exit.  The new form is automatically saved and the design screen will close.  

10. The form is now ready for use in the Data Manager Menu.  To use the form, select Data Manager,  Monthly Data Entry, and either double-click on Peggy Well or click Open.
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11. The form will be displayed:
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Lesson 3.4.2: Other Monthly Data Entry Topics

· Using Advanced settings to set colors, fonts, etc…
· Entry Form Groups 
Lab 3.5: Custom Data Entry Design
Design data entry forms that can be customized to look any way you want.  They can be designed to look like your paper forms, perform calculations for lab/operator benchsheets, etc.  Data may be entered for any number of variables and variable types in any order.  Custom data entry forms can also be printed out for use as bench sheets in the lab or field.
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From the main menu select Design, Custom Data Entry Forms:
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2. Click on cell B3. 
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Select Locate, Hourly Variable: 
4. Fill out the form as follows:
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5.  Click on Heading Tab:
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6. Click OK and the variable linkages to the cells will be done.  [image: image151.png]QoK |




. The cells in column C are now ready to accept entries.
[image: image152.png]



7. Click on D3 and select Locate, Hourly Variables
8. Fill out the form as shown:
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9. Click OK and the variable linkages to the cells will be done.  Continue adding all the listed variables.  
a. V3142
b. V3242
c. V3342
d. V3442
e. V4011
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V5031
10. Save the Form:

11. Close Custom Data Entry Design using File, Exit or [image: image154.png]
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Select Data Manager, Custom Data Entry and double click the Lab Turbidity form:
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 Your form is ready for use: 
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Lab 3.6: Graphs
Graph Pac uses the information from Data Manager to develop four types of statistical analyses:

Time Series Plot
Produces a graph of up to five variables over a user-defined time period. Line, bar, 3D and other graphic effects can be displayed on the screen or printed.  These Plots are often called trend plots and make it easy to spot changes in condition.  Moving averages can eliminate static for a clearer picture.

Correlation Plot
Produces correlations between two variables over a user defined time period.  A dead time or time offset can be established between the two variables.  Resulting curves can be given a linear, geometric, exponential or third-order polynomial and can display on the screen or printed.  This technique can quantify the relationship between two variables making it useful for prediction.

Probability Plot
Produces cumulative probability plots of one variable over a user-defined time period.  Resulting curves can be given a linear or logarithmic fit.  Plots can display on the screen or printed.  This graphs major application when planning for expansion of the facility.

Multiple Linear Regression
Produces linear correlations between one dependant variable and up to seven independent variables over a user-defined time period.  Graphs can display on the screen or printed.  This is a powerful predictive device often used to predict BOD.

Variable Analysis Group 
Produce a variety of different graph types, including Trend graphs, Year over Yea, Individuals-Moving Range grapgh, Histograms and compare graph, for a variables
Once the statistics are complete, Graph Pac formats and plots several different types of graphs.  These plots may be displayed on screen, or sent to the printer. In this lesson, we will create and display plots for the first two statistical routines, as they are the most commonly used. 

Multi-put has already been covered refer to section xxx. Probability and Multiple Linear Regression are fully documented in the Help File. Variable Analysis Group will be covered in a later section.
Lesson 3.6.1: Time Series Graph

To illustrate use of the Time Series Graph, develop a graph to trend the plant flow vs Raw Water Temperature and Turbidity.  

1.  Select Graph Pac, Time Series.
2. Change the start Date to 7/1/2009 and the End Date to 7/31/2009.  Change the graph title by  dragging the  mouse to highlight “Data Over Time” and type “Raw Water Study”.  
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3. Select V1003, V1031, and V1021 from the variable lists and click the View button. 
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WIMS figured out the scales and colors for you.  You can change to a variety of looks using the many buttons available at the top of the graph.  
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The Daily Average for Raw Water Temperature and Raw Water Turbidity are being plotted.  This is because Group Data By is set to Daily and these variables are hourly.  You can also group data by 15 Minute or Hourly.  

To improve this graph put the Raw Water Turbidity on the Secondary (right) Y-Axis.  This will allow comparison of the variables more effectively.  Remove V1021.  Click on the Overlay (2nd Y Axis) tab and add V1021.  Click View.
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4. Click View and the new graph will be displayed.

[image: image159.png]11i Time Series Graph -

3 | & | Protseus | Stats [Favintnine vline v |LabelX-aus everyauto -] Amotse| ] 15| H 0| < | vuows | >]
| ) et | | avc] st B[ | [ [ wg] 4|

Raw Water Study

E)
2
z
)
g
a
a
[}
-

I I I I
T T T T
o ms ms o wmr

Date (7/1/2009 to 7/31/2009 )

/ PantTotal infuent / Raw Water / Rawviaster  / Raw ater
Fow Temperature Daly  Turbidty (Daly  Turbidty (Daiy.
Avg) Avg) Avg)





To get the day and exact value for a point on the graph,  click on a point on the line and WIMS displays the Date and Value for the point.
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5. Click OK.

The controls at the top of the Time Series Graph window.
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Various statistics can be added to the plot by clicking on the Stats button.  
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At this time, you do not need to add anything to the graph, click Cancel to return to the graph.

To customize go to the top row control bar (see Graph Pac Buttons), click on the second dropdown arrow to reveal the Graph Type/Style list.  Choose “Line w/Symbols”.
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Using the button bar, set some graph properties.  
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Each button allows setting of different properties and corresponds to one of the tabs on the Graph Properties window (see figure below). 

Each tab displays a group of related properties.  You can access these property settings by clicking on the button bar.  If you don’t know which button is which, just pick any one then find the Tab you need when the Properties window opens.  

· Click on the Markers tab

· Click the Color drop down list and change the blue to yellow.

· Drag the Symbols/Size scroll bar to increase the symbol size.  

· Click one of the red data points in the sample graph on the Markers tab, and the color bar will turn red. 

· Select the solid circle from the Symbol drop down list and click OK. 
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Save the graph for future use.  Click Save.  Give your new graph a Title, we named ours Raw Water Study, and click OK.  This design is now saved. 
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Close the Graph Window to return to the Time Series Setup form then click Close to close the Time Series Setup form.

The next time you want to view that graph, click Load.    [image: image166.png]



Click on the title of the graph you want to load.  You can change the date range if needed. Click OK.  The graph will be displayed.
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Consult the User Guide for additional information.  

Lesson 3.6.2: Correlation Plot
In this lesson, the relationship between Raw Water Turbidity and Alum Usage is determined.  Correlation graph creates a scatter graph with various curve fits allowing you to compare any two variables.  The Correlation Coefficient of the curve-fit allows you to determine its validity or goodness of fit.  In this case we want to determine that we are feeding Alum based on the Raw Water Turbidity.  

Select Graph Pac, Correlation from the main menu.
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This is the Correlation Input Screen.  There are four curve fits: Linear, Geometric, Exponential, and Third Order.  The equations are shown.  After you enter a date range and pick two variables to be related, WIMS will calculate the constants (a, b, c, &d) for each curve.  Calculated variables can then be set up with these equations to predict process performance.  The Coefficient, which is a measure of the goodness of fit, is also calculated for each expression.
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1. Set the dates for last month.  

2. Set the Graph Title to “Raw Water Turb vs Alum Usage”.  

3. Select the Independent Variable “1024 Raw Water Turbidity Average”.  The independent variable is the one thought to control the dependent variable.  That is true only if we obtain a decent coefficient of correlation.  

4. Select “Alum Day Tank Combined Usage” for the Dependent Variable.    
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5. Click the View button and the graph is displayed.    [image: image171.png]8 View
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6. Close the graph window by clicking [image: image173.png]


 or [image: image174.png]


. 

A correlation coefficient of .6 is not much better than flipping a coin.  Of course, we know that rainfall has a strong effect on flow after looking at the time series plot.
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Other Topics

· Probability Plot

· Multiple Linear Regression

· Multi Graph Output

Lab 3.7: Designing Dashboards
Dashboards allow you to display a spread report on the WIMS opening screen.  The dashboard can be designed with buttons to create shortcuts to certain parts of the WIMS program such as displaying a form, report or graph. Dashboards can also show key parameters such as gauges, trends, and tables.  

Each user can be assigned an individual dashboard or share a dashboard with other users.  You may want to design a dashboard for operations, one for management and one for the lab.  Each user assigned to a shared dashboard still logs in with their individual credentials, so the audit trail will remain accurate.

Lesson 3.7.1: Designing a Dashboard with the Wizard
Use the Spread Report Wizard to design a dashboard.  When the Wizard is finished, you will have a basic, formatted dashboard.  You may edit the layout provided by the wizard at anytime to suit your own needs.

1:  Open Spread Report Design and Select  Design, Spread Reports
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2:   From the File Menu, click on the [image: image176.png]


 button.
3. Click [Next >] on the Wizard’s Introduction screen then select the Dashboard Report Type
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Click [Next >]  and Pick the Data Entry Forms you want shortcut buttons for
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Click [Next >] and Pick the Spread Reports you want Print Preview shortcut buttons for

The next screen prompts for a list of variables for which to display summary values.  The intention is to summarize your KPI’s but any list of variables can be chosen.  The list on the selected side can be rearranged with the up & down arrow keys.
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Click [Next >] and select saved graphs to preview from a Dashboard Button

The Dashboard Wizard creates a basic dashboard. Save this report and edit as needed.
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Lesson 3.7.2: Designing/Editing a Dashboard Manually
Once the Wizard is finished (above) or if you wish to edit other existing dashboards, open the Dashboard Spread Report in the Spread Report Designer.  Background colors, fonts, text colors, boarders etc. are edited as they would be in any normal Spread Report.  This section will focus on adding or editing dashboard elements.

Open the dashboard to be edited in the Spread Designer. (Design/Spread Reports)
Locate a Button

Create a button to open a Monthly Data Entry form.

1. Select the cell in which the button is to be placed.  Alternatively, a group of cells can be merged to create a larger button.  The example merges cells D15 & D16.
2. Merge cells D15 and D16

3. Go to Locate, Dashboard Element, Button
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Choose Menu Item: Monthly Entry
Choose Form: Filter Review
Set Caption: Filter Review
The caption of the new button will be displayed with the font type, size and style of the cells that contain it.
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Move an Existing Button
To “move” an existing Dashboard Button drag and drop it to the new location.

To move a button using Drag & Drop:

1. Clicking on a Dashboard Button does not select the cell it resides in, so use the arrow keys to select the cell containing the button.  If your button is in a group of cells, you do not need to select the entire group.
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2. Point to any side of the outlined cell, when the cursor becomes an arrow, click to drag, then release to drop.
Edit an Existing Button
The ampersand (&) is a special character when creating certain Windows objects.  For instance, it is used to indicate that the next character will be the Access Key in a menu.  The key combination [Alt]-F then X can be used to exit many programs.  The ampersand is used to make these menu items appear as File and Exit.  To use an ampersand (as in a report title Filter & Flow report) use a double ampersand, “&&”.
To edit an existing button:
1. Select the button to be edited.

2. Go to Locate, Dashboard Element, Button just as if you were going to create a new button.

3. Edit the Caption text to read “Monthly Filter Review”

4. Click [OK]
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Locate a Gauge
Add a Linear Gauge indicating the latest value of the Outdoor Temperature.
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Locate the data point onto the report. Go to Locate, Report Summary.

2. Select the Outdoor Temperature variable, # 911.  This is a 15-Minute Parameter connected to the SCADA Interface.

3. Select “Last” for the statistic.

4. Click [OK]

5. Merge a column of cells. Go to Locate Dashboard Element, Linear Gauge. Use the following settings:
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Click [OK] and the resulting “Thermometer” will be displayed.
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Assigning Dashboards to Users

Assign a Dashboard to yourself:

1. Go to Preferences, My Preferences









2. Scroll to the Setting “Home Dashboard for 'Tutorial – Sandy Beach WTP” and click the button in the Value column.

3. Select the Report you want as your Dashboard and click [OK].
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Click [Save] on the My Preferences window, [OK] when the confirmation window appears, then click [Close] on the My Preferences window.
As a Super User or a Manager with proper access, you can assign a dashboard to other users.
Assign a dashboard to another user:

1. Select Preferences, Other Users’ Preferences.
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2. Click [Edit] in the row for the user you will assign the dashboard to.

3. Scroll down until you find the Setting “Home Dashboard for 'Tutorial - Rocky Creek WWTP” and click the button in the Value column.
4. Select the Report you want as your Dashboard and click [OK].
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Set a Default Dashboard for All Users
You can specify a default dashboard to all users with no dashboard assigned or for new users.  Typically, a user sets their dashboard using My Preferences or an admin uses Edit Other Users Preferences to set the dashboard for other individual users.   The user's dashboard setting OVERRIDES the default dashboard setting.
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ADVANCED USERS ONLY!!!! 
1. Find the report id of the Dashboard report you want to set as the default.  Go to Design, Spread Reports then File, Open.

2. Click on the Report Title of the report to see the report’s ID number.

3. Use the Hach WIMS SQL Console for these tasks. 

4. The default dashboard is set in the facility’s SETTINGS Table.  If a record with a SETTING of NULL_DASHBOARD already exists, edit the CURVALUE to be the ID of your Dashboard Report.  If you need to insert a new record, the AUDITUSER and AUDITTIMESTAMP fields are not required.

Edited Existing NULL_DASHBOARD Record:
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Inserted New NULL_DASHBOARD Record:
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Review - Run the Spread Report Wizard and add a gauge



Lab 3.8: Securing Data
There are several methods to secure data in WIMS including:

· User Setup: Setup users as Read-Only or Entry to ensure they do not edit or delete data

· Use Entry Group Manager to allow only certain users to forms, e.g. lab personnel can get into Lab data entry forms but not operations forms.

· Use Data Approval to lock approved data

· Use Lock Data to lock ALL data before a specified date.

· Use the Variable’s Data Read-Only flag to mark data imported from other systems as Read-Only. 

Lesson 3.8.1: Data Approval Setup

Data Approval Levels can be setup that allows you to verify and lock data.  When data is entered, that data point’s approval status will be set to the current user’s Minimum Approval Level.  Data can then be approved and the status of the data point is changed.  If a data point’s status is outside the users approval level, that data is locked from edit/delete for that user.  

Go to System Tables, This Facility, Data Approval Setup:
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Users “Enter” Data, managers Approve it.  Therefore, we need to setup a level called Entered which is below FINAL APPROVAL.  Click [image: image187.png]


, type “Entered” and click OK.  
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The New level is automatically placed at the bottom of the list.  That is correct, click OK.  












The new level will be created.  Pick a foreground color for the data cell on the data entry forms.  Click the Pick button and choose a color.  HINT:  Choose a darker color as data entry forms always have a white background and lighter colors are hard to see.  

The [image: image188.png]Approval User Setup



 is used to set each user’s ability to edit and approve data.  In the example below, 

Example 1: user OPS (User Type set to “USER”) 

· When Entering new data, that data will be set to ENTERED (Min Data Approval Level for the user)

· Edit/Delete any data that is at the ENTERED level.

· View approved data (i.e. Level is FINAL APPROVAL); this data will NOT be able to be edited/deleted 

Example 2: user JAS (User Type set to “USER”) 

· When Entering new data, data will be set to ENTERED (Min Data Approval Level for the user)

· Edit/Delete any data that is at the ENTERED or FINAL APPROVAL level.

Approve data to FINAL APPROVAL level.  

Unapprove data, set FINAL APPROVAL data back to ENTERED (or any appropriate level)
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Lesson 3.8.2: Locking Data 

The lock data feature prevents any changes to data on or before the specified date.  Once locked, data cannot be edited, deleted, or recalculated.  New entries cannot be made on or before the lock date.  
This feature is typically used after monthly reports have been completed and allows you to ensure that the data cannot be tampered with.  Only users with Manager or Super user privileges are allowed to change the lock date.  
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Steps to lock data:

1. Go to Data Manager, Lock Data
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2. Enter/pick a date. Click [image: image190.png]Qok



.  All data will be locked on and before the date: 


Data Entry forms will show the locked data with a light blue background.  
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Lesson 3.8.3: Using the Variable Read-Only flag
The Data Read-Only flag marks all data for the variable as Read-Only and prevents new entries from being made in WIMS.  This is typically used when data is imported from another system such as SCADA or LIMS.  Note: Only Super users can uncheck this field.  

1. Go to System Setup, Edit/View Variables:
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2. Move to the variable to mark as Read-Only.  Check the Data Read-Only option:
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3. Existing data will be read-only and gray in Monthly Data Entry.  NO new entries can be made into this variable.  Only WIMS interfaces (SCADA, LIMS, etc.) can write/edit data to variables marked as Read-Only.
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Lesson 3.8.4: Prompt to Save Variable Edits

There is an Admin Console setting that when set will prompt to save changes when editing variables in System Setup, Edit/View Variables.  Prompting to save changes will help you avoid making unintended changes to variables.  

1. Go to System Setup, Admin Console.  Note:  Only Super Users can access the Admin Console. 
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2. Scroll to the “Prompt users whether to save changes when editing variables” setting near the bottom of the General Settings list.
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3. Set the value to 1. Click [image: image197.png][ save change:.



.Click [image: image198.png]


.

4. Go to System Setup, Edit/View Variables.  Change the Name to “Influent Flow Total”.  Click Next and you will be prompted to Save changes.  Click No and your changes will NOT be saved.
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Lab 3.9: Security

WIMS controls access to functions of the program through its own security system.  Each user is assigned his/her own username and password.  The Audit Trail uses the username that is used for login.

NOTE:  You MUST be logged into WIMS as a SUPER user to administrate security.  


Setup of Security consists of the following steps.  

1. Setup Users – Facility Access and User Type.

2. Setup of Data Approval Levels

3. Setup of Data Entry, Report, Logbook, and Graph Group Managers

4. Use Copy User to setup new users



Lesson 3.9.1: User Setup

Go to System Setup, User Setup.  If you do not have that menu option, you are not logged in as a Super User.  
[image: image200.png]



You will be prompted to verify your password:
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Enter your password and click OK.  The main User Setup screen will be displayed.  
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There are seven user types: Super, Manager, User, Entry, Read Only, Icon Select, and None.  Each user is assigned a user type for each facility.  This allows a single user to be permitted different levels of access to different facilities.  The access levels granted by each user type are as detailed below.

User Type Description

Super
Full access to all Facilities. Is the only user type with access to User Setup.  The first user defined must be a Super user type.

Manager
Has access to all WIMS functions except User Setup and Admin Console.  Cannot remove the read-only flag in Edit/View Variables.

User
Has full access to Data Manager (except for Lock Data), Report Pac, Graph Pac, Design, and Utilities.  System Setup is disabled though Edit/View Variables is allowed in Read-Only mode.

Entry
Can enter data using Monthly Data Entry forms (default or those designed by others). Data previously entered may not be edited by Entry user type.  New data entries may be edited only until the data has been refreshed to the form either by changing the current month or loading another form.  Existing reports may be previewed or printed.  Can generate any type of graph in Graph Pac. Design and System Setup are disabled.  Can Export Data and change their password in the Utilities menu.  Additional functions may be provided to an Entry user via Shortcut buttons created by Mangers or Super Users for them.

Read Only
Data Manager, System Setup and Modeling are completely disabled.  Existing reports may be previewed or printed.  Any type of graph generated in Graph Pac.  Read Only users can Export Data and change their password in the Utilities menu.

Icon Select
Users access is limited to items accessible with the shortcut buttons created for that user.  The entire menu system is disabled with the exception of the Help Menu and Open Facility and Exit on the File Menu.  New Spread Reports may be created and existing reports may be opened.  Changes to Spread Reports can only be saved under a new report title using Save As . . . (Save, Save as Template, and Delete are not available to this user type).

None
No access to the listed Facility.  This User Type is understood if the facility selected does not appear in the users list.

Create a user for an operator.  He will need to enter data and output reports/graphs.  His basic user type would be “User”.  

1. Click [image: image203.png]


.

2. Enter a User Name. HINT: Use Initials or their Windows Username.
3. Enter a password.   The user will be able to change their password on their own, so you may want to set to something simple and instruct them to change their password when they first login (Go to Utilities, Change Password).

4. WIMS supports Windows pass-through login.  If Allow Windows pass-through login is set in Admin Console (see http://www.opssys.com/instantkb/article.aspx?id=11883 ) and the Windows Login Name is set the user’s Name and Password will automatically be filled in on the WIMS login screen.  
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5. Optionally, enter Name and Comments.  
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Click on Facility Access


7. To add a new facility, click on the [image: image205.png]() Add Access



 button. It will load a list of available facility databases in a facility browser:
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All selected facilities will be added to the user's facility access matrix.  Any facilities that are selected in the Facility Browser that are already in the user's matrix will be updated to the Default User Type. You can also change a user's User Type for a single facility by using the drop-down in the Facility Access Matrix:






NOTE : To assign the same user type to all facilities, use the "All" File Name shortcut: Any named facility settings take precedence over the "All" facility setting






9. The User Specific Settings allow    you to set for each user options such as Variable Browser Size, which Daily Detail forms will be used, etc. 

NOTE: The user can also set some of their preferences (depending on user type) using Preferences, My Preferences.

Lesson 3.9.2: Organizing and Securing Data with Group Managers

Group Managers help you organize and secure your data entry forms, reports, graphs and logbooks. Group managers allow you to:

· Organize your reports into regulatory, daily process, and summary reports

· Allow only certain users the ability to run the regulatory reports

· Allow only lab personnel to use the lab data entry forms

Entry Form Group Manager:

Hach WIMS comes with three groups already created:  Monthly Data Entry, Custom Data Entry, and Daily Detail Entry.  You can edit or delete these groups.  You can also create a new group:
1. Go to System Setup, Group Managers, Entry Form Group Manager:
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2. Click [image: image208.png]Create Group



.  The following window will be displayed:
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3. Enter a name for your Group.  In this example, Operator Forms is our group name.  

4. Set each user’s permissions by checking the Use and Design checkboxes. Specifying access permissions is a simple process.  Users who have access to the current facility and who are not super users are listed in the “Access Permissions” column on the left.  Click on the checkboxes to active the read or write permission. Use means a user can open the data entry form and enter/edit data using the form.  Design means they can design the form (using Design, Monthly Data Entry or Design, Custom Data Entry, etc.).  Design users can also add columns to a monthly data entry form when using the form.   

NOTE:  SUPER users always have Use, Design privileges to all forms.

You can use the “Apply to” feature to set access permissions for current group for all users of a certain type (See User Setup for more information on User Types).  For example, if all Mangers should have Use/Design Access to all reports in the Group then you would use the “Apply To” feature.  

· Select a user group from the drop down list.

· Click the appropriate permission level buttons.  (Notice how the “Access Permissions” on the left changes each time you click on a different button).

5. Click OK to create the Group.   Users with Use permission to the group will now see Operator Forms on the Data Manager Menu.
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6. Follow a similar process to setup your Report, Graph, and Logbook Groups.

Setting up Logbooks

The Log Book Manager allows you to create and set permissions on log books.  Log Books are used to track text entries or comments.  The system has one default logbook called “Comments” that everyone has read, add, edit, and delete privileges to.

For example, you may want to have separate logbooks for the lab, operations, and solids handling.  Also, you would want to specify that only lab personnel could add to, edit or delete entries in the Lab Logbook.  

Example 1: Setup a Solids Handling Logbook.  
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1. Go to System Setup, Group Managers, Log Book Manager
2. Click the [image: image211.png]Create Log Book.



 button, a blank Log Book is now created.  

3.  Type in “Chemical Logbook” a name for the new Log Book in the Log Book Name field.

4.  The user list is displayed in Access Permissions box.  (Super Users are not listed, they have all rights). There are two ways access permissions can be set:

a.   Manually by checking the boxes by each users name to give each user custom access rights.
b.  Selecting the user type from the Apply to dropdown menu and clicking on one of  these:  

· [Can Only Read] (Allows the user group to read the Log Books entries) 

· [Can Read / Add to] (Allows the user group to add to the Log Books entries, but not change (or remove))  

· [Can Read / Add To / Edit] (Allows the user group to have full access over the Log Books entries.  They can add, delete and modify entries) 

· [Have no Access] (Revokes all access privileges from the user group.  The user group will not be able to access, or even see Log Books name)
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Example 2: Changing a Log Books Access Permissions
To Change a Log Book’s access permissions, click on the desired Log Book from the Available Log Books list.  Then change the permissions as described above.  After any changes to a Log Book, you must click on the [image: image213.png]Save Changes



button or your changes will be lost.  To undo changes you have done, click on the [image: image214.png]


 button. 

Lesson 3.9.3: Copying a User
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After you have added users it is easier to copy a user and preferences to setup subsequent users.
1. Go to User Setup.
2. Verify your password
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Click on the user you want to copy:









4. Click [image: image215.png][ Copy User



 and enter new User Name, Password, etc..  Facility Access will already be setup for you.  Click OK to save.

5. Click [image: image216.png]
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Go to Preferences, Edit Other Users Preferences:

7. Check the Copy box next to the user to copy preferences. 
8. Check the Paste box next to ALL users to copy the preferences to the new user name
9. Check the Copy Preferences and Group Access option.
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.

Lab 3.10: Getting Help 
You can get answers to your questions using a variety of tools that the IIM team provides.

Customer Support Portal:

Signing up for the Customer Support Portal allows you to see all of your open support cases including their status, notes, etc.  This Portal is where patches and updates are available for download.  You will also be notified by email when updates are available. 

CREATE ACCOUNT AND ADD LICENSES
1. Go to http://www.hachiim.com/support  or   http://www.opssys.com/support_login.aspx 
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Create Account.  Click [image: image218.png]Create account



.  The new account page will be displayed.
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Enter your information and click the [image: image219.png]Create account



 button.   The following message will be displayed.
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You will be sent an email with a link to activate your account.  Activate the account and return to the login page:
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5. Add Product License for your in-office programming license.  Use the [image: image220.png]


 button.  NOTE:  You MUST add all of your customer’s WIMS and/or Job Cal licenses to your account to be able to create cases.


Enter in your Serial Number for WIMS or Job Cal.  Serial numbers can be found on the login (splash screen, on your disk, or go to Help, About.  

CREATE CASE

1. Login -  Go to http://www.opssys.com/support_login.aspx 

2. Click [image: image221.png]


:
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Please provide as much detail as possible.  Screen shots of the error message if applicable is required.  If a series of screen shots would provide the detail, use Word and paste the series in.  

Click [image: image223.png]


.

Review your cases:

Click [image: image224.png]My Support Cases



 button or the My Support Cases link in the support links section.  
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Click on the link (e.g. 53565) to view the case, add comments to the case, or mark as resolved.  

Use the [image: image227.png]


 to link to an existing case id that your tech support rep gives when you call or email cases in.  
Download patches
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1. Login to your account at http://www.hachiim.com/support     
2.  Click Enter - for downloads for the product.  
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3. Click Download link for Product to download:
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4. Click on Mirror1 to download.  This will download the update for the product.   
5. Click the How to Deploy link for specific information on how to install the patch.  For example, to install the client patch:

· Run the ClientPatch741.exe to extract the patch files to a folder.  

· Run Server Setup to upload update.   

· Run WIMS client, go to Help, Support, Install Latest Update (Runs ClientUp.Exe).
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Tech Support Number:  800-677-0067, press 2 for Tech Support.

1. Support will ask for your name and phone number.  

2. If this is an existing support issue, please have that CSCP number available.  

3. If it is a new support issue, we will require the software license key.  
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WIMS Serial Number can be found on the login/splash screen or go to Help/About

b. Your Job Cal Serial number is found on the Help, About Screen.  From the main Job Cal menu, select Help, About: 
Section 4: Advanced Topics
Lab 4.1: Scheduled Tasks
WIMS allows users to set scheduled tasks to automate some frequent tasks in order to create efficiencies within normal workflows.  Tasks that may occur using this WIMS function include:

· Calculating equations automatically

· Automatically generating on a date/time basis:

· Spread Reports

· Time Series, Correlation, Multi-Graph outputs

· WIMS database backup

· Compliance Engine event scanning

1. Go to System Setup > Scheduled Tasks from the WIMS menu:
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2. Click New to create a new scheduled task:
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3. Enter a name for the new task:
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4. Click on the Schedule tab, select the frequency for which to run this task from the Perform This Task: dropdown field; set the time and day (depending on frequency selected) in Run At.:
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5. Click on the What to Do? tab and select the task to schedule from the dropdown field.  Depending on which task is selected, select the report or graph to generate as part of that task.  Complete the date(s) for which the task should be executed.  Options differ based on the task:
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When selecting the date(s), there are options as to whether to run the task for Relative Date(s) (e.g., Today, Yesterday, Last Month, etc.) or Absolute Date(s) (e.g., 6/1/2014):
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6. Click on the Output tab and select where the output of the task should be sent, what format it should be sent in, and any other details necessary for successful execution.

Note: You will only have options on the Output to tab when certain tasks are selected to execute (e.g., Generate Report, Generate Time Series Graph, etc.).  Tasks such as Calculate Database and Backup Database either don’t have physical outputs or are sent to a default location upon every execution.
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7. Click OK to close and save the new scheduled task.

8. To test the new task without waiting until the specified date/time set during setup, click on the task in the list and then click Run Task Now!:
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9. To edit an existing Scheduled Task, click the Edit button next to the task you wish to modify and make changes as specified in steps 3-8:

Exercise 1: Schedule Calculation
Create a new Scheduled Task to automatically perform all calculations in the WIMS database at 15 minutes past every hour for today and the previous day (i.e., calculate yesterday’s and today’s equations every time the task executes).

1. Click New
2. On the Task tab, set the name/description of the task to be “Calculate Database”

3. On the Schedule tab, set the Perform This Task: field to be “HOURLY” and the Run At field to be “15”

4. On the What to Do? tab, select “Calculate Database”, set the Use Dates field to “RELATIVE”, and set the Select Relative Dates field to “YESTERDAY AND TODAY”.

5. Click OK.

6. The output should look like this:
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Exercise 2: Email Report
Create a new Scheduled Task to automatically to email the previous month’s NPDES report to the Plant Manager at 8:00 AM on the 15th of every month.

1. Click New
2. On the Task tab, set the name/description of the task to be “Email NPDES Report”

3. On the Schedule tab, set the Perform This Task: field to be “MONTHLY”, set the Run At Hours field to be “8”, set the Run At Minutes to be “0”, and set the Run On section to be “Day 15”.

4. On the What to Do? tab, select “GENERATE REPORT”, select the “NPDES” report from the Select Report to Generate field,  set the Use Dates field to “RELATIVE”, and set the Select Relative Dates field to “LAST MONTH”.

5. On the Output To tab, select the “EMAIL” radio button in the Output to Device field, select “PDF” in the Output Format section, enter a valid email address in the Email Result To field, and enter a description in the Custom Subject: field.

6. Click OK.

7. The output should look like this:
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Lab 4.2: Complex Calculations

WIMS provides a Math Toolbox with formulas that are specific to the water and wastewater industry.  Many of the calculated variables are straightforward.  However, some of the variables required for reporting can be complex to set up and understand.  
4.2.1 Working with Daily Detail variables in Calculations

To work with variables with different frequencies you must understand how WIMS handles them in a calculation. It is possible to use a variable that is gathered every hour in conjunction with a variable that is gathered every day. WIMS can calculate an average in a few different ways. WIMS can use the Daily Detail (DD) functions to store an average in a certain variable. This is useful if you want this value to be trendable or trackable. You can also use the avg function in the spread report tool to take the average of the cell values in a certain range. This is useful for quick, one-time reports. 

Example 1: Calculate an hourly value from two hourly inputs.

V1 - Hourly Parameter
V2 - Hourly Parameter
V3 - Hourly Calculation, equation = V1+V2
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Example 2:  Calculate a Daily Result from Daily and an Hourly Variable 

1. Select System Setup, Edit/View Variables.

2. Copy V1021 to V1025. Name it “Raw Water Turbidity Daily Max”. Select Type Calculated. 
3. Select the Equation Tab. Enter the equation: DDMAX(C2, 0, 23). Click Exit. [image: image240.png]I Fist| 4 Prev| b Newt| b tost| b New|bx Del| it Findl il tns[ & Vors| O copy| & B
Info Var# 1025 L]

Name Ran Water Tubidiy Dap Ma Uniits [NTU =

e | Userooied | WoLAds | (o | Addionaie | Gialtes }
i Unis | OpinaPin | GulyConio | Eauation | efecs )

€

¢

&

- x[ = ([>] B .| [ CoeckEauaton]

V1025 = [DDMEX(CT021.0.23)

~

e Water Tarondty [NTUJ] ~ DDMAX, [Rew Weter Tty NTUIL 0,25
A S e WP NI VY





4. Open Monthly Data Entry Form “Raw Water Monthly Review”.  Insert V1025. Click the Calc button. Exit.
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5. Design a new spread report. Design, Spread Reports.

6. In cell C3 Locate, Daily Detail Values Select Variable V1021 (Raw Water Turbidity) and select Place Time besides Data.  Click on Heading Tab and place Name and Units. Click OK. [image: image242.png]0101109 00:59
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7. In cell F3 Locate->Daily Values Variable 1025. Display 1 value and Place Date beside Data[image: image243.png]Variable
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8. In cell G5 type “=MAX(D5:D28)”. This is calculating the maximum of the values in that cell range

The maximum can be displayed in two ways. The difference is not what you will see on this particular report but in the ability to track trends using graphs and other functions.
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Example 3: Calc an hourly result from Daily and an hourly Variable 

In this case, refer to the variables (the daily variables value for the day will be used for each hour of the day in the calc). 
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Example 4: Calculate the Weekly Maximum of a four hour variable.

Since we are only calculating one value a week, we will setup our calculated var as a Daily Calculation. We MUST use the optional Time Increment parameter of the WMAXn math toolbox function. Since the source variable's frequency is 4 hour we need to set the Time Increment to BY4HOUR. 

V17536 - A four hour parameter.

V17537 - A Daily Calculation with equation set to WMAX7(C17356,BY4HOUR). The formula will return the maximum value of variable 17356 for the week definition 7 (Sunday thru Saturday) and will look for data every 4 hours(BY4HOUR). 
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WARNING: The Time Increment should match the frequency of the source or input variable (V17536). If we do not specify the Time Increment the function will use a time increment of the target or calculated variable(V17537). Since that variable is daily, BYDAY would be used. This would return the wrong result. Since the formula Time Increment would be BYDAY, the formula would look at the first 4 hour period of Sunday, July 6th, increment by 1 day and look at the first 4 hour period of the 7th (and find .07, NOT .14), increment by 1 day, etc... Therefore, it would only look at the first value of each day to find the Max. It would therefore not find the .14 at 8:00AM. 

If a function does not allow the Time Increment to be set (such as MOVn) you should use an advanced Math Toolbox function (GETAVG)

Example 5: Calculate the ratio of Volatile Acids (tracked every 4 hours) to Alkalinity (tracked hourly)

V8001 is a 4 hour parameter
V8002 is a Hourly Parameter
V8003 is a 4 hour calculation

V8003 = V8001/GAVG(C8002)

Since the target variable is 4 Hour, use the Group function GAVG to calculate the average of the 4 hourly values in the 4 hour slot:
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4.2.2 Calculating with Text Variables

WIMS cannot calculate a Text Result, only numeric (or numbers with symbols/data qualifiers).  However, you can refer to Text Parameters in your calculations.  
WIMS stores the Text Value and a numeric value in the database when entering a Text Parameter.  The numeric value stored depends on the List of available values.  If no list is specified, the numeric value for any text entry will be 1 (one).  If a list is specified, the value will be the row number of the list item selected.  For the Operator-In-Charge Shift 1 variable shown below, if BSS is selected the numeric value stored will be 1 (one).  If DSS is selected, the numeric value will be 2 (two), and so forth.  Therefore, SPD would be 8 (eight):
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A numeric value is stored for the Text in calculations.  Use the Audit Trail function to verify the numeric value stored:
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Example 1: Detect days Operator in charge Shift 1 is JRD. 
IF(V130=5,1,BLANK)
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NOTE: TEXTEQ function could also be used.


Example 2: Use of ISBLANK, LV, and simple assignment with Text Variables.
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Example 3: Graphing Text Variables
A Time Series graph will plot the numeric values.  Therefore you can see the change of state of the text variable on a graph: 
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Overriding Calculated Variables 
Calculated values can be overridden in WIMS using the Force function.  "Forced" data values appear red on data entry screens.  Once a value has been ‘Forced' into a calculated variable, any subsequent calculations (that variable on that day) will not re-enter a calculated value (i.e. the forced value remains unless manually removed by the user).

For example, a runtime meter gets entered each time the site is visited (several times a week).  We use the ADIF function to calculate the estimated daily run hours based on the runtime meter.  The runtime meter breaks and the meter is replaced.  The new meter starts at a random value, the ADIF function will calculate an erroneous value:  
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NOTES: 
Once a value is forced, subsequent calcs do NOT recalculate the value, the force value remains.  Use the [image: image257.png]& Remove



 button on the Force Entry Form to remove the Force flag and allow the calc engine to recalculate the value.  

You can Force a value from most data entry forms (Monthly, Custom, etc.) by right clicking on the value.  Use the Data Exception Report to review Forced values.

Lab 4.3: Advanced Statistical Analysis 
WIMS provides a variety of statistical tools that analyzes your data for predictions, outlier detection, etc. 
· Basics of Statistical Process Control (SPC).
· How to calculate Control and Warning Limits

· Detect outliers and remove the outliers from analysis

· Build a SPC chart based on the calculated limits

· How to interpret SPC charts

· How to interpret Correlation graphs

· Predict the probability of an Effluent BOD violation
· Build a model to predict our Effluent BOD based on easy to obtain parameters.  
Lesson 4.3.1: Understanding Statistical Process Control
The concepts of Statistical Process Control (SPC) were initially developed by Dr. Walter Shewhart of Bell Laboratories in the 1920’s, and were expanded upon by Dr. W. Edwards Deming, who introduced SPC to Japanese industry after WWII. 
The goal of SPC is to identify when the process variation is caused by events outside the normal variation inherent in the process.  Terms:
· Common Cause variation: Chance variation that is inherent in the process and stable over time.  

· Special Cause variation: Uncontrolled variation, which is unstable over time – the result of specific events outside the system.

If we can identify the Special Cause variations, this will trigger us to dig deeper to find the root cause and potentially adjust the process to take the Special Cause into account.  However, what we want to avoid is adjusting the process, researching, etc. when the variation is just inherent to the process, i.e. a Common Cause.  
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Process Variability

The histograms will approximate a Normal Distribution with a classic Bell curve. 
In order to work with any distribution, it is important to have a measure of the data dispersion, or spread. This can be expressed by the range (highest minus lowest), but is better captured by the standard deviation (sigma). The standard deviation can be easily calculated in WIMS.

Example Spread Report with basic SPC calculations
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Why Is Dispersion So Important?

Often we focus on average values, but understanding dispersion is critical to the management of processes. Consider two examples:

· If you put one foot in a bucket of ice water (33 degrees F) and one foot in a bucket of scalding water (127 degrees F), on average you’ll feel fine (80 degrees F), but you won’t actually be very comfortable!

· If you are asked to walk through a river and are told that the average water depth is 3 feet you might want more information. If you are then told that the range is from zero to 15 feet, you might want to re-evaluate the trip.
Control Limits

Control Limits are used to calculate the odds that a given value (measurement) is part of the same group of data used to construct the histogram.  With properly set control limits, we can identify when the process has shifted or become unstable.  With this knowledge, we can then study that particular situation, identify root cause, and develop a plan to minimize or eliminate these occurrences.  
Shewhart found that control limits placed at three standard deviations from the mean in either direction provide an economical tradeoff between the risk of reacting to a false signal and the risk of not reacting to a true signal – regardless the shape of the underlying process distribution.

If the process has a normal distribution, 99.7% of the population is captured by the curve at three standard deviations from the mean. Stated another way, there is only a 0.3% chance of finding a value beyond 3 standard deviations. Therefore, a measurement value beyond 3 standard deviations indicates that the process has either shifted or become unstable (more variability).

A point above the upper control limit has a very low probability of coming from the same population that was used to construct the chart – this indicates that there is a Special Cause – a source of variation beyond the normal chance variation of the process.

A special cause is anything which leads to an observation beyond a control limit.
How to interpret SPC Charts

The main purpose of a SPC Chart is to detect a Special Cause (i.e. a process that may not be in control).  SPC charts allow you to detect potential problems before they become obvious.    Once a special cause is identified, action can be taken to remove it.  
The goal of SPC graphs is to identify problems but not over alert.  The following rules are generally accepted in interpreting SPC Charts.

Rule #1 
If one or more points fall outside the upper control limit (UCL), or lower control limit (LCL). The UCL and LCL are three standard deviations on either side of the mean. [image: image259.png]Point
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Rule #2 
If two consecutive points are above or below the Warning Limits. The UWL and LWL are two standard deviations from the mean
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Rule #3 
If eight or more points fall on either side of the mean (some organizations use 7 points, some 9) [image: image261.png]T2 consecot
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Rule #4 
If there is a run of six or more points that are all either successively higher or successively lower (some organizations use 5 points, some 7).
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Note:  There are additional rules that some organizations use, but the above rules are generally used in all SPC systems. 
Lesson 4.3.2: Calculating Control Limits in WIMS
Control limits are defined as follows:
Upper Contol Limit (UCL) – Average + 3 * Standard Deviation

Upper Warning Limit (UWL) – Average + 2 * Standard Deviation

QC Mean – Average

Lower Warning Limit (UWL) – Average - 2 * Standard Deviation

Lower Contol Limit (LCL) – Average - 3 * Standard Deviation

WIMS offers several tools to calculate these limits.  The simplest is the Variable Analysis Graphs.
1.  Go to Graph Pac, Variable Analysis Graphs
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2. Pick the variable you want to analyze.  In this case we will look at V1021 MLSS.  The control limits will be calculated with and without outliers removed.  Click on the Control Limits, “Calculated” option:
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3. Click option “Calculated with outliers removed”.  In this case, the control limits are indicating there are no outliers.  In statistics, an outlier is an observation point that is distant from other observations and should not be used in calculating Control limits or considered a special cause variation.  In other words, the point should be thrown out of the analysis (it may be caused by measurement or human error).  WIMS provides several techniques to statistically detect outliers.  See the Stats tab and help for specific information on the Outlier detection.  
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Lesson 4.3.3: Building SPC Charts Based on the Calculated Limits

The Variable Analysis Graphs form gives you three quick views that allow you to determine if the process is in statistical control and identify any special causes that need to be addressed.  

1. Staying in the Variable Analysis form, pick the Show Trend Graph, Show Individuals-Moving Range Graph, and Show Histogram Graph:
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2. Click the [image: image267.png]s G



 button. The 3 graphs will be displayed.  
Interpreting the trend graph:
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Analysis of the control chart to identify any Special Causes using the following rules:

Rule #1 
If one or more points falls outside of the upper control limit (UCL), or lower control limit (LCL). The UCL and LCL are three standard deviations on either side of the mean.

Rule #2 
If two consecutive points are above or below the Warning Limits. The UWL and LWL are two standard deviations from the mean.

Rule #3
If seven or more points fall on either side of the mean (some organization use 8 points, some 9) 

Rule #4
If there is a run of five or more points that are all either successively higher or successively lower (some organizations use 6 points, some 7).

Looking at the graph above and analyzing the data:

Rule #1 – No Special Causes as there are no points beyond the UCL or LCL

Rule #2 – No Special Causes as there is not a case of 2 points in a row beyond the warning limits.  There is one on 1/29/2014, but not 2.

Rule #3 and #4 are harder to apply visually.  Click the [image: image269.png]QC|



 button and the graph will be analyzed for Special Causes according to the QC Flag Detection Rules:  
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The QC Check will analyze the data and list all QC Flags (Special Causes) according to the rules specified on the Variable Analysis form.  Click on the QC Flag description and the graph will highlight where the flag exists on the graph with two red horizontal lines.

Interpreting the Individuals-Moving Range Graph:

An individuals-moving range (I-MR) chart is a pair of control charts for processes and is used to determine if a process is stable and predictable, it creates a picture of how the system changes over time. The individual (I) chart displays individual measurements. The moving range (MR) chart shows variability between one data point and the next. Individuals and moving range charts are also used to monitor the effects of process improvement theories.
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The individuals graph is similar to the trend graph, the difference is that it plots points one right after another regardless of the date of the value.  For example, if you take a sample every Monday and Thursday the trend graph will show a point on Monday, a point on Thursday with a line between the points.  An individuals graph would show Monday’s value as the 1st point in the graph; Thursday’s value would be the second point, etc.  

Determining QC Flags is the same.  Click the QC pull down and select Individuals:
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To determine QC Flags for the Range Graph, click the QC pull down and select Range.  A moving range will only have a UCL (Avg of data set + 3 Standard Deviations) and a UWL (Avg of data set + 2 Standard Deviations).  Lower control limits do not make sense as we always want lower variance, and the range cannot be negative.  
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In this case there are no QC Flags (Special Causes).  

How to interpret Histogram Graphs

A Histogram shows the frequency of certain values or categories in a bar chart.  It can be used to answer questions like:
What range do most of my results fall into?

Is the data central around a set point or average?
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This histogram shows that most of our data is between 3600 and 3893, however when we go below those values it seems to drop of steeply. Hopefully, this can start a discussion around why and lead to better 
understanding of the process.  

How to use the compare graphs
A two variable trend graph and a scatter graph (Compare graphs) are a pair of charts to determine if there is a statistical correlation between two parameters.  

Care must be taken when looking at correlations as correlation is not causation.  In other words, if two variables correlate it may mean that one affects the other, but it may mean that there is another overriding parameter that causes the correlation.  
There is a correlation between Effluent TSS and Effluent BOD.  Does the Effluent TSS cause the Effluent BOD to be high.  No, they are both dependent on the plant process working well and if we correlated Effluent TSS and Effluent BOD to SRT, F/M ratio we could infer that those parameters affect our Effluent quality.
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Example 1:  What affects our Effluent BOD?
1. Go to Graph Pac, Variable Analysis Graphs
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2. Pick 4011 – Effluent BOD as the Variable to Analyze:
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3. Click the [image: image275.png]Suggest



 button.  This will display the Correlation Calculations for Effluent BOD (Correlation Heat Map)
This form shows what variables correlate to the Variable to Analyze.  It provides four different line/curve fits to the data and calculates the Coefficient of Correlation (Coeff of Cor) for each.   The correlation coefficients of correlation are a measurement of the goodness of fit.  The higher the Coefficient, the better the fit (1.0 being a perfect fit).  The list is sorted by the Linear Regression Coefficient of Correlation.  

In this example, we find that the Eff BOD Duplicate correlates to Eff BOD the best.  However, while this makes perfect sense statistically, this provides no insight into what affects our Eff BOD.  However, MLSS is second on the list and something we can control.
4. Click on the MLSS row, the Selected Independent Variable will be updated and click OK.
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5. Click Graph:
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What we see is an inverse relationship between MLSS and Eff BOD.  As the MLSS goes up, the Eff BOD goes down.  Using the scatter graph we can look at the line drawn thru the points and use it to predict the Eff BOD based on MLSS.  

What is the predicted Eff BOD at a MLSS of 3600?  Look where the line cross 3600 and look at the Y-Axis value.  The answer is approximately 30.  
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Lesson 4.3.4: Year over Year 

The Year over Year graph displays a single variable for a date range selected vs the same date range for the previous one to five years.

Go to Variable Analysis Graphs 
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a) Choose your Variable and date range. Influent Flow and May 2014
b) Check the Show Year over Year Graph

c) Click [image: image280.png]il Graph
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Lesson 4.3.5: Predicting the probability of a violation

A Probability graph plots data from lowest to highest and draws a best fit line (linear regression line).  This line can be used to predict the probability of a value occurring.  It can be used to answer question like:

· What are the chances are flow will be greater than 5 MGD

· What are the odds that we will have an Effluent BOD greater than the limit of 30?

Example:  Build a Probability Graph for Effluent BOD
1.  Go to Graph Pac, Probability
[image: image282.png]Hach WIMS Muki User v7.50 - SUPER @ “Wastewater Tutorial” on LOCALHOS,
e OwaNarser ReporFac [GaphFae] Deign e prfer
G [ Srered  Tmeseie
Pty
Wkt e Poresion

Varisble Anslyss Gophs

Multple Output








2. Choose variable 4011 – Effluent BOD and set your date range.  
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3. [image: image544.png]


Your graph will be displayed.  The blue line tells you that there is about a 65% chance that a value will be less than 30 (or a 35% chance it will be above 30).  

· [image: image545.png]i L fise s ST Ve R VIR Vel L LT
n System Setup Modeing Pocket OPS Utites e

My Preferences
Edit Other Users Preferences




Click [image: image284.png]


 .  This button calculates a % or value for a given value or % by simply calculating the point on the line. In this example enter a value of 30 and click [image: image285.png]Calculate



 and we find that there is a 64.17% chance of a value will be below 30.  

: 
Lesson 4.3.5: Building a Model to Predict Effluent BOD
Multiple Linear Regression produces a multiple variable linear correlation (the effect of many variables on one variable) plot.  Whereas Correlation graphs draw a straight line through the data points, MLR draws a plane through the n dimensional data points (using the least squares method).   If more than 3 independent variables are chosen to be used in the model, the equation will be calculated but no graph will be shown.

Example: Predict Effluent BOD

1. Go to Graph Pac, Multiple Linear Regression
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2. Select Effluent BOD as the Dependent Variable and set the date range.

3. Click [image: image287.png]Suggest



 to see which variables have the highest correlation to Effluent BOD.  In this case, we would choose V1151 Final Clarifier Blanket Height and V4041 Effluent TSS.  Choose V1151 Final Clarifier Blanket Height and click OK.  The first dependent variable will be filled in.  
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4. Choose V4041 for the 2nd independent variable.

5. Click Calculate and the equation predicting Effluent BOD (Y) will be shown.  The View button will display a 3 dimensional graph, however the equation is what we need to predict the Effluent BOD.  
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4. Calculate the Predicted BOD where the Blanket Ht is 6.8 feet and the Effluent TSS is 14 mg/L

Effluent BOD = 6.2441 + 0.8529(V1151) + 0.5220(V4041)
Effluent BOD = 6.2441 + 0.8529(6.8) + 0.5220(14)
Effluent BOD = 6.2441 + 5.7997 + 7.308

Effluent BOD = 19.35 mg/L

Exercise:  Setup an Effluent BOD Predicted Calculated variable.  
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Lab 4.4: Variable Admin Tool 

The Variable Admin Tool allows Super Users to quickly change the variable setup by deleting variables, assigning variables to locations, etc.  The Variable Admin tool is found in the Hach WIMS Admin Console.
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WARNING:  There is no UNDO for these actions.  Changes are saved automatically.  BACKUP YOUR DATABASE BEFORE USING THE VAR ADMIN TOOL.
BUTTONS:
	[image: image292.png]@ Delete|




	Deletes the currently selected variables

	[image: image293.png]& Ed




	Loads the currently selected variable in Edit/View Variables.
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	Search and Replace text within Variable Names, Units, or StoretCodes.  You can also append text to the beginning or ending of the Variable Names, Units, or StoretCodes.
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	Print preview of the spreadsheet.
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	Exports the spreadsheet to Excel
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	Assigns the currently selected variables to a new location.  Displays the Location browser for selection of the new location.
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	Copies the current location and variables.
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	Moves the current location (sheet) to a new spot in the location order.  Displays the Location Browser to select the location that the current location will be placed in front of.  
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	Starts the Var Admin Wizard to renumber your database, set entry limits based on historical data, and default StoretCodes based on Variable Names based on user specified options.
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	Closes the form.

	
	

	
	


Variable Admin Wizard
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FIELDS:
Renumber Variables based on the currently displayed order: Will set the VarNum for all variables starting at 1 and incrementing by user specified value.  Each new location will start at the Next ten, Hundred, or Thousand depending on settings.  

Increment By:  Sets the value to increase the VarNum by.  For example a setting of 3 means you will have VarNums 1,4,7,10,13..., a setting of 5 will give you 1,6,11,16, etc.
Start each location at the next: For each new location start at the next power of 10, hundred or thousand.  For example Raw Water has variables 1,6,11, and 16, the next location Flash Mix will start at 20 if set to Ten, 100 if set to Hundred, and 1000 if set to 1000.  

Calculate Entry Min and Max based on historical data for variables with no Entry Limits setup:  Analyses the variables data (all data in the database) and populates the Entry Min and Max settings based on the following settings.  NOTE:  If a variables has the Entry Min or Max already setup (i.e. they have a value), the limits will NOT be overwritten.  A minimum of 10 values must be in the database for the values to be calculated.

Plus and Minus 3 standard deviations:  Calculate the Average value and standard deviation of all data for the variable and set the Entry Min to Avg - (3 * Std Dev) and the Entry Max to Avg + (3 * Std Dev)

. 

Lab 4.5: Compliance Engine 
The compliance and verification engine does an incoming data check to make sure that values are within defined limits. Those limits can be regulatory limits or user defined control limits. 

The Compliance Engine scans your database for Limit violations, Entry Limit Exceedances, and QC Flags.  Records are created in the event table making reporting and trigger reports easier to deal with.

Setting up the Compliance Engine
1. Setup variables for the Compliance Engine to Scan. 
Go to System Setup, Edit/View Variables and select a variable. Select the Options Tab and select Compliance engine settings you wish to track for this variable.  Repeat process for all variables.
NOTE:  ALL THE OPTIONS WILL BE SELECTED FOR EACH VARIABLE BY DEFAULT. COMPLIANCE ENGINE WILL ONLY SCAN VARIABLES THAT HAVE LIMITS, ENTRY LIMITS OR QC LIMITS SETUP. IF THESE FIELDS ARE BLANK AND THE COMPLIANCE SETTINGS ARE SELECTED, THE COMPLIANCE ENGINE WILL NOT SCAN THAT VARIABLE.
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HINT:  You can use SQL Console and the following update SQL Statement to remove the checks from all variables:

UPDATE VARDESC SET COMPLIANCE_LIMIT=0,COMPLIANCE_QC=0,COMPLIANCE_ENTRY=0

Set to -1 to check options.  

 2. There are two ways to manually scan the database for violations. 

a. Data Manager, Events: Select the Month to scan for violations and click the  [image: image304.png]Scan



 button. Events for violations will be displayed for the month
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b. Data Manager, Compliance Engine: Select start and end date to scan. By default, all variables with Limits, Entry Limits, and QC Limits are displayed.  Click the  [image: image306.png]Scan



 button to run the Compliance Engine. Events will then be logged into the Events table.

3. Setup a Scheduled Task to Scan for Events to have the system automatically check for Events.  
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Go to System Setup, Schedule Tasks.  
· Click New to create a new Task
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Enter a task description “Compliance Engine Scan”.  
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· Click on Schedule Tab.  Choose “Hourly” and 1 
              Minutes after the hour:
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Click on What to Do? Tab.  Choose SCAN FOR EVENTS and select LAST 30 DAYS for date range:

· Click [image: image307.png]
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4.  Setting up Trigger Reports

Download the VIOLATION_EVENT_REPORT and VIOLATION_EVENT_TRIGGER spread report templates to your client\templates folder (C:\HachWIMS\Client\Templates by default)
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Go to Design, Spread Reports.  File, New and choose the violation_event_report.ss3:
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Go to File, Save As and save the report as “Violation Event Report”. 

Go to File, New and choose the violation_event_trigger.ss3 template

This report will act as a trigger to output the Violation Event Report when there are violations to be reported. Trigger Reports allow you to design reports that will only be run by the GNR server when a certain trigger is met.  In Spread Report Options you designate a cell that when it contains any value it tells the GNR server run the listed reports.  The Trigger Cell can contain any spread formula or if statement.  

Schedule the report to run once a day and if a new event has been created in the last 24 hours it is counted.  In cell C2 we have the following query that returns all events in the report date range.  
=VAL(SQLFIRST(1,1,"","Select COUNT(*) FROM EVENTS,EVENTTYPE WHERE EVENTS.EVENTTYPE_ID = EVENTTYPE.ID AND  DateStamp >= #P1# AND EndDate < #P2# AND System_Class = 1",1,1,DATE(1,"mm/dd/yyyy",1),DATE(-1,"mm/dd/yyyy",-2)))
System_Class=1 specifies that only Violation Events should be counted.   Your EVENTTYPE table should be setup as follows:
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To see the QC_Flag and Entry Limit Flag events, use:


“AND SYSTEM_CLASS IN (1,2,3)”

Cell A1 has a simple formula and is used as the trigger cell.  

=STR(if(C2>0,"X","")) 

If C2 (the count of events in the last 24 hours) is greater than 0 set to X else blank

Go to File, Report Options and click on the Trigger Tab:
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Go to File, Save As and name “Event Trigger Report”
Exit Spread Design




5. Schedule a task to check once a day if there is anything to report:

Go to System Setup, Scheduled Tasks 
In Scheduled Tasks, schedule the Run Report Trigger task that will evaluate the triggers and run the report if the trigger cell contains any value.
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Setup your Task as follows:

Lab Entries are completed by 2PM so we scheduled for 2:03 PM to check right after all entries are made for the day.  
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Click OK to save:
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See the Compliance engine video in Knowledge base article: http://www.opssys.com/instantkb/article.aspx?id=11697  
Exercise: Change report to only report if a new Violation Event has been created in last 24 hours

Hints:  Use the AuditTimeStamp in the Events table query. In the Violation Trigger Report set C4 to current Datetime and use DateAdd function to calculate 1 day prior in cell C3.  

=VAL(SQLFIRST(1,1,"","Select COUNT(*) FROM EVENTS,EVENTTYPE WHERE EVENTS.EVENTTYPE_ID = EVENTTYPE.ID AND  EVENTS.AuditTimeStamp >= #P1# AND EVENTS.AuditTimeStamp <= #P2# AND System_Class = 1",1,1,C3,C4))
In the Violation Event Report  unhide column A and edit the SQL Query in cell A3 to use the AuditTimeStamp.
Lab 4.6: WIMS Database Concepts 
WIMS data is held in a DBMS (MS SQL Server or Oracle).  Understanding the underlying data structures will allow you to use the SQLFIRST, SQLRESULT spread functions and the SQL Statement Dashboard button.  
This section is intended for advanced users only.  Users should have a basic knowledge of database concepts and SQL Statements.  

WIMS uses a client application to connect to a Microsoft SQL 2005 or later database server (also supports Oracle).   It uses the ADO/OLEDB access technology to connect.  Examples are for MS SQL.
WIMS data is stored in separate MS SQL Server databases under one MS SQL Server.  There is one WIMS Admin database, called OPSROOT that contains a variety of tables including the Facility List, User List, Login History, etc.  This database MUST always exist and is created during install (for WIMS Multi-User) or with Server Setup (for WIMS Multi-User with Database Support).  
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For each WIMS Facility Database a MS SQL Server Database (catalog) is created and contains the exact same table definitions as well as triggers and stored procedures as other WIMS Facility Databases.  All WIMS Facility Databases start with "OPS".  In the example below, we have 3 facility databases (OPSDWTUTOR, OPSOtayH2O, and OPSWWTUTOR) and OPSROOT.  

Upon logon, the client application will attempt to connect as user OPSDBA.  The default catalog (database) for this user is OPSROOT.

WIMS Data Structures

Each WIMS facility database contains the exact same table definitions as well as triggers and stored procedures.  

WIMS uses several tables to store its data. This data is usually brought in by SCADA/LIMS interfaces, ADOCALC, and user manually entered data.  The data storage tables are organized by the frequency of the data they are storing. WIMS uses the narrow data slotted storing format, meaning that for a particular frequency slot (hourly variables allow storing 24 value per day), there can only be one record. 

DATATBL is used to store daily data (VARTYPE= C, T, or P). It is uniquely indexed on two columns: DATESTAMP & VARID. VARID is a foreign key to VARDESC.VARID. DATESTAMP column stores the date of the current data point. 

How to find a variable’s VARID:

VarId is an auto assigned unique number that never changes that identifies a variable.  It is shown in the lower right corner of the Variable Edit form:
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DATATBL Column descriptions:

AUDITUSER – Contains username of the user who last changed the datapoint
AUDITTIMESTAMP – Contains the date stamp of the last change

DATESTAMP – part of the table’s unique index

VARID – part of the table’s unique index

CURVALUE – floating point value of the current datapoint

TEXTVALUE – text representation of the current datapoint’s value

STATUS – holds the data approval level for the current datapoint

FORCED – Indicates whether a value has been forced in place of a calculation (i.e calculation result override)

Daily detail data (Hourly, 15 Min data, etc…) is stored in the DATADD+ tables. Their structures resemble the one of DATATBL.  For example:

DATADDH - Stores the hourly frequency data for variables with a VarType of H, N, and B.

DATADD4 - Stores the 4 hour frequency data for variables with a VarType of 4,G, and E.

DATADDF - Stores the 15 Minute frequency data for variables with a VarType of F,V, and X.

DATADD3 - Stores the 30 Minute frequency data for variables with a VarType of 3,W, and Q.

DATADD5 - Stores the 5 Minute frequency data for variables with a VarType of 5, Y, and R.

DATADD1 - Stores the 1 Minute frequency data for variables with a VarType of 1, S, and A.

Daily detail sample comments are stored in the DataDDx_C where x is the Vartype.  For example:  DATADDH_C is the sample comments table for hourly data.

Daily detail audit trail is stored in the DataDDx_AT table where x is the VarType.  For example: DATADDF_AT is the audit trail table for 15 Minute data.

WIMS uses stored procedures SEEKDATEVARID, SEEKDDH, SEEKDDF, SEEKDD5, SEEKDD4, SEEKDD3, SEEKDD1 to seek data in DATATBL, DATADDH, DATADDF, DATADD5, DATADD4, DATADD3, DATADD1 respectively. 

Table Listing:
APPROVALFILTER - Rarely used.  Holds an sql query that can be used on the Data Approval Form (Select Filter button) to load a customized recordset on that form.

APPROVALINI - The list of approval levels for the facility.

AREA - The area setup information.

AREA_I - The area additional info.

BIOSOILTEXTURE - Not Used

BOD - Not Used

BODCRIT - The BOD Criteria settings.  

BODRECS - The BOD Manager sample/bottle information.  Contains the detailed BOD information (Bottle #, Sample Volume, Initial DO, etc.) for each BOD bottle.

BODXREF - The BOD Manager Sample Setup information.

CALCGRP - The saved calculation group for use with Calc Data Block (Load and Save Group buttons)

COMMENTS - Contains result comments for daily type variables.

DATADD1 - Data table for 1 minute variables

DATADD1_AT - Data audit trail table for 1 minute variables

DATADD1_C -  Result comments table for 1 minute variables

DATADD1_I - The data additional information table for 1 minute variables.

DATADD3 - Data table for 30 minute variables

DATADD3_AT - Data audit trail table for 30 minute variables

DATADD3_C -  Result comments table for 30 minute variables

DATADD3_I - The data additional information table for 30 minute variables

DATADD4 - Data table for 4 hour variables

DATADD4_AT - Data audit trail table for 4 hour variables

DATADD4_C -  Result comments table for 4 hour variables

DATADD4_I - The data additional information table for 4 hour variables

DATADD5 - Data table for 5 minute variables

DATADD5_AT - Data audit trail table for 5 minute variables

DATADD5_C -  Result comments table for 5 minute variables

DATADD5_I - The data additional information table for 5 minute variables

DATADDF - Data table for 15 minute variables

DATADDF_AT - Data audit trail table for 15 minute variables

DATADDF_C -  Result comments table for 15 minute variables

DATADDF_I - The data additional information table for 15 minute variables

DATADDH - Data table for hourly variables

DATADDH_AT - Data audit trail table for hourly variables

DATADDH_C -  Result comments table for hourly variables

DATADDH_I - The data additional information table for hourly variables

DATATBL - Data table for daily variables

NOTE - See Comments table for Daily variable result comments.

DATATBL_AT - Data audit trail table for daily variables

DATATBL_I - The data additional information table for daily variables

EGROUP - Entry Form Groups

EGROUPACCESS - Security matrix that defines access to different Entry Form Groups

EVENTFILTERS -

EVENTS - The list of WIMS Events

EVENTS_AT - Events audit trail table

EVENTS_I - Events addtional information table.

EVENTTYPE - List of Event Types.

EVENTTYPEACTIONS - 

EXPORTHDR - Basic header information on an Excel Export List. 

EXPORTVARS - Variables for an  Excel Export List 

FILES - Simulates a file system for WIMS clients. Files are stored as Binary Objects (BLOBS).  For example, when a spread report definition is saved, the spreadsheet is saved as a blob in the FILES table. 

GGROUP - Graph Groups

GGROUPACCESS - Security matrix that defines access to different  Graph Groups

GRAPHCORR - The settings for saved correlation graphs

GRAPHLIST - 

GRAPHPROB - The settings for saved Probability graphs.

GRAPHSAMPLE - The settings for saved QC Analysis Graphs

GRAPHTS - The settings for saved time series graphs.

HDE -  Daily detail form header information such as an hourly or 15 minute data entry form.

HDEVARS - Variable list for a daily detail form.

ICONS - No longer used.  May contain the list of shortcuts imported from an OPS 32 database.

LC_FILTERSETTINGS - Lab Cal Saved Calendar Filters

LC_LABSECTION - Lab Cal Lab Section List Table.

LC_LASTSAMPLENUM - For each date, holds the the highest sample number assigned to that date.   

LC_MDLDETAIL - MDL (Method Detection Limit) Study detail (i.e. trial) table.

LC_MDLHEAD - MDL (Method Detection Limit) Study header table.

LC_METHOD - Lab Cal Method list table

LC_PEOPLE - Personnel list table.  Used in BOD Manager and Lab Cal.

LC_QCTEST

LC_QCTYPE - The Lab Cal QC Type list.

LC_SAMPLE - Lab Cal Sample Header information table.

LC_SAMPLECUSTODY - Lab Cal Sample's Chain of Custody Information

LC_SAMPLEDEF - Lab Cal Sample setup (definition) header infomation.

LC_SAMPLEDEFTEST - Lab Cal Sample setup test schedule (detail) infomation.

LC_SAMPLETEST - Lab Cal Sample test result information (i.e. analyzed by, analysis start and complete time)

LC_SAMPLETYPE - Lab Cal Sample Type List table

LC_SCHEDCUSTOM - Lab Cal Custom Schedule.  For example, when scheduling a sample and you choose Custom Schedule, this table holds the dates for the custom schedule.  

LC_SCHEDCUSTTEMP - A temporary table used during scheduling of custom schedules.

LC_SCHEDTEMP - A temporary table used during scheduling of custom schedules.

LC_SCHEDULE - Lab Cal Schedule information.   

LC_TEST - Lab Cal Test List Table

LC_USERDEF - Sets the captions for the user defined fields in the LC_SAMPLE and LC_SAMPLEDEF table

LC_WORKSHEETS - Holds the header information for the for Lab Cal Worksheets (i.e. BOD Manager).

LC_WS_STATUS - Lab Cal Worksheet Status lookup table.

LC_WSGROUP - Future

LC_WSGROUPACCESS - Future

LIMITS - Regulatory limits for variables.  Links to VarDesc.VarID

LOCATION - Contains the list of Locations/sampling points. Variables (VARDESC) links to this table via VARDESC.LOCID=LOCATION.LOCID to set the variable's location

LOCTYPE - Location type lookup table.

LOGBOOK - Logbook list.

LOGBOOKACCESS - Security matrix that defines access to different Logbooks

LOGBOOKENTRIES - Contains the Logbook entries (i.e. comments) for each logbook.

LOOKUPTABLES - Lookup table data.

MDE – List of Monthly Data Entry (MDE) forms.

MDEVars – List of variables for each Monthly Data Entry (MDE) form.

PICKVAR - Variable Browser settings.

PICKVARFILTERS - Variable Browser Filters

PPBASIN - Activated Sludge basin setup information for WIMS Modeling.

PPCLARIFIER - Activated Sludge clarifier setup information for WIMS Modeling.

PPFLUXCURVES - Activated Sludge flux curves setup information for WIMS Modeling.

PPPARAMETERS - Saved coefficients (parameters) used for WIMS Modeling.

SETTINGS - Holds Facility specific settings such as LockDate, VARSETUP_LOCKED, etc.
SPFORMS - Custom Data Entry Form list.

SPRPTS – Contains a list of saved Spread Reports

SPRPTSGROUP – List of available Spread Report Groups

SPRPTSGROUPACCESS – Security matrix that defines access to different Spread Report Groups

UDCAPS - Sets the captions for the 10 user defined fields in the Vardesc table.

VARDESC - Stores information about all parameters/variables tracked by WIMS.

VARDESC_AT – Audit Trail information for the VarDesc table.

VARDESC_DEL – Deleted records from the VarDesc table.  A variable can be restored from this table.  Data is not removed from the Data tables when a variable is deleted (the records are orphaned), therefore the data will be recovered when the variable is restored.

VAREQ – Historical Equations for variables.

VARQC – Quality Control Limits for variables. 

Example Queries:

As a Super User, get to the SQL Console:

1. Find all variables that are not assigned to a location. 

Select VarNum,Name,Locid from Vardesc where Locid not in (Select LOCID from Location) OR LocId is Null
2. Show most recent values for all variables coming from a SCADA Interface (Interface ID=1)
Select NAME, Units,EntryMin,EntryMax,Curvalue,DateStamp 
FROM datatbl,VARDESC, 
(Select max(Datestamp) as LatestDate, Varid as subVarid from datatbl Group by Varid ) SubMax 
WHERE datatbl.DateStamp = SubMax.LatestDate and datatbl.Varid = SubMax.SubVarid
AND DATATBL.VARID = VARDESC.VARID AND VARDESC.G2_INTERFACE_ID=1
ORDER BY NAME

ORACLE NOTES:

All WIMS software (clients, adocalc, serversetup, interfaces) attempts to connect to Oracle as OPSROOT. The OPSROOT user is also a schema owner. This schema contains tables, sequences, triggers and stored procedures. 

OPSROOT.FACILITY is the table that contains the list of all WIMS facilities. To get the list, run a query: 
select filename,name from opsroot.facility

The ‘filename’ field contains the oracle user for the particular facility. OPSRTUT is the user for the Tutorial facility. OPSRTUT is again a schema owner. All tables, sequences, stored procedures, and triggers that belong to the Tutorial facility are owned by OPSRTUT. 

For instance, to get a list of tables for OPSRTUT, run the following:

SELECT table_name "Table" FROM sys.dba_all_tables WHERE owner = 'OPSRTUT' AND nested <> 'YES' ORDER BY 1

To get a list of stored procedures, run :

SELECT object_name FROM sys.dba_objects WHERE object_type = 'PROCEDURE' AND owner = 'OPSRTUT' ORDER BY 1

Lab 4.7: Using Interfaces 
Hach WIMS (Water Information Management Solution) interfaces transfer data seamlessly and automatically to Hach WIMS from your SCADA or LIMS system. The data is stored in the secure, central WIMS database.  Interfaces are available for all water and wastewater SCADA and most LIMS systems.  
The System Administration Guide should be used for additional training content
· Import data on a continuous or scheduled basis
· Export data from WIMS in a format convenient to you
Interfaces can be direct or indirect, standard, custom or with Hach UDG1000.  To determine which interface to a SCADA or LIMS system is needed:
Direct: When the network environment that Hach WIMS will reside in is directly connected to the SCADA/LIMS system data source.
Indirect: When the network environment that Hach WIMS will reside in is not directly connected; for example:
• Physically disconnected networks
• Blocked by firewall policies
• Blocked by Network permissions
• Separate domains
Note: All Indirect Interfaces will also work in a direct connection environment.
Standard Interfaces: commonly used and readily available in the WIMS software
Custom Interfaces: developed for a customer’s specific implementation when a standard interface is not available. 
Lesson 4.7.1: SCADA Interfaces

Import summarized data from your SCADA/Historian system on a scheduled basis (once/day, once/hour). GE Fanuc iFix and Historian (Intellution)

· Wonderware Historian and HistData DDE

· Rockwell RsView32, RsViewSE, BizWare Historian

· OPC, CSV, OLE DB

· Many more, for a complete list go to http://www.opssys.com/instantkb/Article.aspx?id=12932
Section 4.7.1.1: Installing a SCADA Interface

Identify the source data and pick the appropriate interface.  Items to consider:

1. Is the source data available (i.e. on the same network) as the WIMS database?

If you cannot directly connect from a WIMS PC to the source data you will need to use an indirect interface.  You may need an indirect interface if WIMS and your SCADA data are:

• Physically disconnected networks

• Blocked by firewall policies

• Blocked by Network permissions

• Separate domains

2. How is the source data configured?

Many SCADA systems have multiple options for how data is logged.  For example, Rockwell can log data to DbaseIV files, SQL Server, or use the BizWare Historian.  If you are using DBaseIV interface Q12186 Direct or Q12535 may be the choice.  If logging to SQL Server, our standard OLEDB interface (Q13207) is the best choice.  The interface documentation should be reviewed to determine the best interface for your source data.  Documentation can be found at http://www.opssys.com/instantkb/article.aspx?id=12932.
3. Interface licensing allows you to switch interfaces at any time at no charge. 

One (1) interface license allows you to run any 1 interface at a time.  For example, you are using the Wonderware HistData DDE interface (Q12097) and update to Wonderware to use the Historian, download and install the Wonderware Historian Interface (Q12180).  Remove Q12097 from your interface list and start using the new interface.  

This also means that you can try an interface and if it is not the correct one, you can  download and install a different interface.  

4. Consider using the free CSV Interfaces.

The SCADA CSV interface (Q12933) and LIMS CSV Interface (Q12351) are free and do not use an interface license.  If your source system (SCADA or LIMS) can produce CSV files that are compatible with the specified CSV formats you do not need to purchase an interface license.   
Download and install the interface

In this example we will install and configure the free SCADA CSV Interface (Q12933):

1. Download the MSI from http://www.opssys.com/instantkb/article.aspx?id=12932:
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2. Launch the MSI by double clicking on it.  

3. Click Next

4. Read and accept the Terms and Conditions and Click Next: 
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6. Choose a folder and click Next:
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7 Click Install:
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8.  The interface will be installed.  Click Finish. 

Configure the interface
We will now run the interface and connect it to WIMS and the Source Data.

Go to Start, All Programs, Hach Company, Hach WIMS, Hach WIMS generic data CSV Files direct interface, Run Interface in Interactive Mode

1. Connect the interface to the WIMS server: 
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2. Upload Definition file to Hach WIMS.
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Browse to the 12933.g2_server_lu file. 
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3. Log into Hach WIMS as a Super User and go to System Setup>System Tables>Entire System>Server-Side Interface Setup:
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4. Click New:

Note:    The License information is in the lower corner.  This license allows for 15 interfaces to be installed and currently 5 are in use. There are six (6) interfaces listed, however 12351 is the free LIMS CSV interface and therefore does NOT count against your license.  
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5. Set the interface to collect data for the interface setup in WIMS:
This step specifies to the interface that it should pull data for WIMS variables Cross Referenced to “SCADA CSV” 
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6. Source Configuration:

Our source files are in e:\SCADA CSV and are Wide Format,1 header row, and Date Time is combined in column 1:
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6. Cross reference variables:
To cross reference V1001 Raw Water Flow #1 we need to study the source data in SCADA to pick the right Tag (ie column) and statistic.  The CSV file has 3 tags for Raw Flow (FIT_INF_FLOW, FQ_INF_FLOW, and FQ_INF_FLOW_PD).  After analysis of the data and interviews with the SCADA admin it was determined that the tags are:

FIT_RAW_FLOW1 – Is the instantaneous flow in MGD taken each minute.

FQ_RAW_FLOW1 – Is a daily totalizer that resets at midnight
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FQ_RAW_FLOW1_PD – Is the previous day’s total flow.

Example 1: Take the average of FIT_RAW_FLOW1 for the day to calculate the total flow. I.E. if we average 2.0 MGD all day that would mean we had a total of 2 MG.  




Example 2: Take the LAST reading of the day of FQ_INF_FLOW to grab the total flow for the day.  
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Example 3: Take the LAST reading ending at 2:59AM of the next day of FQ_RAW_FLOW1_PD to grab the total flow for the day.  

Notice Day After Start is selected.  When retrieving data for Jan 1st, the interface will get data from Jan 1st at 11PM thru Jan 2nd at 2:59 PM.  It will then calculate the LAST statistic on that data set which will return the last reading in that data set (i.e. the reading at 2:59).  For Daily variables, data IS ALWAYS STORED ON THE START DATE.  In this example, it would get the reading at Jan 2nd, 2:59AM and store that as Jan 1st total flow.  

7. Test the interface.  
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Setup the interface to run automatically
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This tells the interface when to run.  The interface actually runs as a Windows Service so you do not need to leave the Interactive Mode software running.  When running automatically the interface gets data for all completed “slots” for cross referenced variables since the last time the interface ran.  

Care should be taken that the source data is ready before the interface is scheduled to run.  For example, the csv files may be placed on the server at 12:15 AM for the previous day.  You should not run the interface before 12:15 AM.  

Section 4.7.1.2: Understanding SCADA data

WIMS SCADA Interfaces (http://www.opssys.com/instantkb/article.aspx?id=12932 for a list) pulls data the SCADA system has logged, summarizes the data, and stores the data in the WIMS Database.  It is important to understand how that data is stored to pull the data the user is looking for from the system. 

Wide vs Narrow Format:
Typically, SCADA data is stored in a timestamped data table in either "narrow" or "wide" format.  A narrow format table usually consist of a record for each Tag/Time with the following structure:

NARROW Format table:

	Timestamp
	Tag
	Value

	1/1/2010 08:15:22
	FIT_INF_FLOW
	2.75433

	1/1/2010 08:15:22
	AIT_INF_PH
	7.6544

	1/1/2010 08:16:22
	FIT_INF_FLOW
	2.65435

	1/1/2010 08:16:22
	AIT_INF_PH
	7.5555

	...
	
	


 WIDE Format table::

	Timestamp
	FIT_INF_FLOW
	AIT_INF_PH

	1/1/2010 08:15:22
	2.75433
	7.6544

	1/1/2010 08:16:22
	2.65435
	7.5555


A wide format table will have a column for each tag.

Understanding Tags:
Tags are the list of points (or things) that the SCADA system tracks.  There are many naming conventions for tags but the most common we have seen are based on the ISA standard:

	TagName
	Meaning

	AIT
	Analog Indicating Transmitter (D.O., pH, ie most Hach Online instruments)

	FIT
	Flow Indicating Transmitter

	FQI
	Integrated/Totalized Flow Indication

	LIT
	Level Indicating Transmitter

	PIT
	Pressure Indicating Transmitter

	PDT
	Differential Pressure Transmitter

	TIT
	Temperature Indicating Transmitter

	ZIT
	Position Indicating Transmitter (Valve Position usually)

	
	

	
	


These are usually used as the Prefix but not always. 

How is data stored:
Typically, a subset of tags are "marked" to be trended (placed in the history tables).  In other words, not all Tags are in the history tables!  Most data is scanned on a scheduled basis (once a minute, once a second, etc.) and placed in the history table.  For example, we select the Tag AIT_INF_PH for trending and a scan rate of 1 minute and the SCADA system will read the current value of the AIT_INF_PH reading and write it to the historian. 

Example 1:  Avg value for the day

If the user wants to know the average Influent pH for the day we would setup the interface tab as follows: 

This would create a query to give us the average value from 1/1/2010 00:00 thru 1/1/2010 23:59. 

NOTE:  Scale Factor is used to convert SCADA Units to WIMS Units.  If the SCADA system tracks the flow rate in GPM and we want it in MGD in WIMS set scale factor to 0.00144. 

500 GPM X 1440 min/day = 720,000 GPD /1,000,000  = 0.72 MGD

OR

500 GPM * 0.00144 = 0.72 MGD

 

Example 2:  Avg value for a plant day

If the plant defines the day from 8AM to 8AM, we need to specify the Stop Time as 8:00, Day After Start. 

Data is ALWAYS STORED ON THE START TIME DATE.  For Jan 1st data, run a query for data from 1/1/2010 08:00 thru 1/2/2010 08:00.  The average value of that data will be calculated and the value will be stored in WIMS on 1/1/2010 (assuming the variable is daily)
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Example 3: Total Daily Flow
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Data is the current reading from the flow meter in MGD.

 Example 4: Total Daily Flows from a totalizer
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DIFF - Takes the last value for the time period (i.e. the last value for the day at 23:59) and subtracts the last value from the previous time period.  Handles Rollover.   This function is best used when you are working with a totalizer that keeps going up until the meter rolls over (like the odometer on a car)

Example Data:
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 Example 5: Flow from a totalizer that resets every day: 
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LAST - Get the last good reading on or before the Stop Time (23:59).  Typically, the data has a saw tooth look:
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HINT:  Be careful with last as the timing of the reset if very important.  If the totalizer resets a little before midnight, it can return the wrong values:
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Example 6: Total flow from a Previous Day Total Flow Tag
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Notice the Stop Time is set to 02:59 Day After Start.  Therefore, when trying to get data for Jan 2nd, the interface will look at the Last good reading on or before Jan 3rd at 2:59AM.  Even though data is pulled from Jan 3rd the data will be stored for Jan 2nd in WIMS.  DATA IS ALWAYS STORED ON THE START TIME DATE.
Example Data:

[image: image336.png]1400

1200

1000

500

500

200





 Questions 

1. Is the tag logged to the historian (AKA trended)?

2. If the point is trended are there multiple tags for this point - IE FIT_FLOW_RATE, FQ_FLOW_TOTAL, FIT_CHANNEL_1, etc.
3. If it is a totalizer, does it reset and if so when does it reset.

4. Can we see the data to view the data for a couple of days?

5. Who setup/takes care of your SCADA system, do you have an integrator or somebody on staff?

From http://www.opssys.com/instantkb/article.aspx?id=13050
Lesson 4.7.2: LIMS Interfaces
Imports approved results from Laboratory Information Management Systems based on user specified Locations (Sampling Points) and Tests (Analytes).  

· ATL Sample Master® LIMS

· Perkin Elmer Labworks
· Promium Element LIMS

· Standard Database – any OLE DB compliant database with a Sample and Results table
· CSV formats
· Many more, for a complete list go to http://www.opssys.com/instantkb/Article.aspx?id=12932
Lesson 4.7.2.1: Installing a LIMS Interface

Identify the source data and pick the appropriate interface.  Items to consider:

1. In what format is the source data available?  Can a View be created in the database to make interfacing easier?  If it is an off-site or commercial lab, what electronic formats, such as CSV, XLS, etc., are available?
2. Interface licensing allows you to switch interfaces at any time at no charge. 

a. One (1) interface license allows you to run any 1 interface at a time.  For example, you are using the Labworks interface and decide to have your lab tests performed by a commercial lab that emails you XLS files. Download and install the Hach WIMS Direct Server-Side Interface to Lab Excel EDD Files (Q13940).  Remove the Labworks interface from your interface list and start using the new interface.  

b. You can try an interface and if it is not the correct one, you can download and install a different interface.  

3. Consider using the free CSV Interfaces.

a. The SCADA CSV interface (Q12933) and LIMS CSV Interface (Q12351) are free and do not use an interface license.  If your source system (SCADA or LIMS) can produce CSV files that are compatible with the specified CSV formats you do not need to purchase an interface license.   
Download and install the interface

In this example we will install and configure the free LIMS CSV Interface (Q12351):

1. Download the MSI from http://www.opssys.com/instantkb/article.aspx?id=12932:
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2. Launch the MSI by double clicking on it.  

3. Follow the instructions to install the interface.
Lesson 4.7.2.2: Configure the LIMS interface

We will now run the interface and connect it to WIMS and the Source Data.  
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Start the interface in interactive mode: 
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Connect the interface to the WIMS server: 
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3. Upload Definition file to Hach WIMS.
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Browse to the 12351.g2_server_lu file. 

4. Log into Hach WIMS as a Super User and go to System Setup>System Tables>Entire System>Server-Side Interface Setup:
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5. Click New:

Note: Notice the License information in the lower corner.  This license allows for 15 interfaces to be installed and currently 5 are in use.  You will notice that there are six (6) interfaces listed, however 12351 is the free LIMS CSV interface and therefore does NOT count against your license.  

[image: image341.png] Senvr-Sde Ineface Setup (=i
) Newodintion] 8 LaunchBeowse]
Goiriion s Verson

2 14162+ Hach WIS Direct Server-Side Interace o dold
[ 12351 -Hach WIS Direct Server-Side Iferface o Ge H
¥ iFuhdrect 12499 - Hach WIMS Indrect Server Side Inferece to G F.
~  UMSOLEED 13618 -Hach WIMS Diract Server-Sice Iterace 0 Ge 1
¥ Wastewster INSOL Ineriace 12180 - Hach WIMS Direct Server Sids Iterace o We |
¥ Water Systom InSOL 12180 Hach WIMS Direct Server Side Interace to WeA
fl I »

Lo Avaltle =16, InUse =5 Tota =20 y





[image: image342.png]4201 Hach S DrectSever S toce o e Dol o

<P Do @ e bt




[image: image343.png]Verson





[image: image344.png][

et

[ee—

Descipion

CotectorTopZaow:

e —

[T ach WIS Dt S i oo
USG5V, Eh Ut v (5 Vs 10|

2
[—#mm
4\&\:\/“».”%“\.0

[—#mm 700 Mo T (05 Carin] g

© Ve

Nowlert

B s oo
(62 Inetace 10:





Name of Interface: Identifies the interface.  When a variable is cross referenced, this is the name that will be displayed in the Interface To field.  

Description:  Used to further identify the interface.

Collector Time Zone:  Used to adjust the time that data from the source system is stored in WIMS.  In almost ALL cases, this should be set to your time zone

Interface's AuditUser Name: In the WIMS Audit Trail, the Name that will be written as the AuditUser.  
6. Set the interface to collect data for the interface setup in WIMS:

This step specifies to the interface that it should pull data for WIMS variables Cross Referenced to “Lab CSV” 
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Source Configuration:

Example File: Source files are in e:\LabCSV.  Set other options and click on Column Mappings.
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Cross reference variables: 
The lab performs testing for our Influent and Effluent BODs and TSSs.  To configure those variables to get data from the CSV files:
· Go to System Setup>Edit View Variables
· Browse to variable 1091 and click on the Interface tab

· Choose Interface To of “Lab CSV”.  Set the Location and Analyte:
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Test the interface: 
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Imported 266 for July 18th 2012 and imported a result comment of BB for July 17th.  Since “BB” is an invalid result in WIMS, the value is imported as a result comment.  

Setup the interface to run automatically
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This tells the interface when to run.  The interface runs as a Windows Service so you do not need to leave the Interactive Mode software running.  When running automatically the interface will import all  CSV files from the Source folder regardless of what date/times the data is for.
NOTES:
· When setting up variables that are importing data from Lab/LIMS, consider setting the “Data Read-Only” flag.  With this flag set, the data will match your Lab data system. Only a Super user can change this flag and edit the data.

· Set the “Data Approval Level to Write With” to allow users to approve data after it has been imported.
Lesson 4.7.3: Hach UDG1000™
UDG1000: automatically collects process data from multiple sources and stores the raw data in a secure UDG database. The data can be consolidated for efficient export to convenient and cost-effective viewing tools like Hach UDG Online Viewer, Hach WIMS solutions, SCADA systems or Excel. 
The data is immediately available for troubleshooting, compliance and analysis. The solution is scalable, additional collectors can be purchased as needed. 
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	Input Collectors (Drivers):
	Exporters ( Drivers):

	· SC1000 via TCP/IP
	· CSV Files

	· Sc1000,sc200, sc100 via modbus RTU
	· WIMS Online Viewer

	· OPC DA
	· WIMS

	· Allen-Bradley PLC
	

	· Hach 2200 PCX Particle Counter
	

	· USGS Web Site
	


Drivers are being added all the time, see http://www.hach.com/udg1000-universal-data-gateway-software/product-downloads?id=15890348901 for latest list of drivers.
A 30 day free download is available.  See www.hach.com/im and navigate to the Hach UDG1000 section for the trial download.  Download the software, evaluation guide, and the manual for more details.
Exercise: Install and configure the USGS Input Collector

Prerequisites:

· UDG1000

· Internet connection (to collect USGS data) 

1. Verify you have the latest UDG1000 Software:

a. Click System,About. The software version and support contact information show. 

b. Click Check for update.  A message identifies whether a software update is available.

c. If a software update is available, click Install to install the update.
2. Start UDG1000
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Select Input, Collectors.  Click the Add button in the lower right corner.
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Choose “US Geological Survey” and click the Add button.
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Name the collector

6. Add site numbers

Provide site numbers to track.  Each site in the USGS data base has a unique 8- to 15-digit identification number.  Reference the USGS site map at http://maps.waterdata.usgs.gov/mapper/index.html
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In this example, we will use 2 sites near York, PA: 01575500, 01570500
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Type Site Number in box, click Add button and the Site will be added to the list.  Repeat for all sites you wish to pull data from.  
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Choose Parameters and the list of available parameters for the listed sites are automatically detected and displayed.  Select the parameters to track and click [image: image355.png]


.
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8. Optionally, select individual parameters in the right pane and edit its attributes.
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9. Set the scheduler to automatically import data from the USGS site.
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10. Verify the USGS site has data for at least one of the parameters:

http://waterdata.usgs.gov/usa/nwis/uv?site_no=01575500 
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Manually import parameter data into UDG1000 to test.
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Exercise: Setup WIMS Exporter
1. Add WIMS Output Exporter:
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Name the Exporter:
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3. Setup the connection to your Hach WIMS DBMS:

4. Cross reference parameters with variables
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5. After selecting parameter(s) to export, edit parameter to cross reference to WIMS database and variable
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6. Manually export data to test cross reference
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7. Verify data was properly imported into WIMS
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8. After test export\import is successful, go back to steps 4 and 5 to continue to cross reference all parameters.

9. Enable auto import and auto export and configure to desired settings.
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Lab 4.8: WIMS doForms Interface

Collect Hach WIMS mobile data with Android, iPhone and iPad mobile devices with doForms™. Your field staff can collect data from anywhere with familiar devices at any time and automatically import the data to your WIMS Data Management system. Requires a doForms Professional account.  Contact doForms www.doforms.com for account set up and information.
Lesson 4.8.1: Form Creation
Rules:

· WIMS supports ONLY the Text, Numeric, Date:Time and Choose One doForms widgets

· Requires one (and only one) Date:Time field on your form

· The doForms ‘Data Name’ MUST BE “Date” for your Date:Time field

· A Date:Time field must be set to have a doForms ‘Kind’ of “Date:Time”

· A Text widget must be a Text Parameter in WIMS

· A Numeric widget must be a Parameter in WIMS

· A Choose One widget must be a Text Parameter in WIMS

1. Log in to your doForms account using your account name, email address, and password (http://www.mydoforms.com/login):
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2. Click Build Forms to begin building your form(s):
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3. A blank form will be presented.  Choose an option from the doForms widgets to create your first field; the widgets represent the data type for your fields.  The widgets are found at the bottom of the form page.
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4. Enter text in the ‘Caption text’ field on the right to set the name of the field as it will be seen on your mobile device.  This will automatically set the ‘Data name’ field using underscores (_) to fill in any spaces in your Caption Text.

Note: See rules above for the ‘Data name’ field for a Date:Time widget; it MUST be changed to “Date”
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5. Repeat steps 3 and 4 for each field you want on your form.
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6. Once the form is complete, select File and click Published under Save Form As...
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Note: Once a form is published, it cannot be modified.  To make changes to an existing form, it must be saved under a new name.

[image: image597.png]JE=8cn )

[S8U8CT BVENTTYPE, SYSTEM_ CLASS FROM EVENTTYPE

e | | ot |

ST s
I
£

3





7. Enter a Form Name and click Save
Lesson 4.8.2: Adding a Mobile Device to doForms Account

1. On the main doForms menu go to Manage > Mobile Units:
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2. Under the Action column, click the dropdown button and select Edit
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3. Enter the devices mobile number, create a PIN, enter a Nickname, and a notification email address for the device then click Change.  This will add this device to your doForms account.
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4. Repeat steps 2 and 3 for each device.

5. Install the doForms App on your mobile devices. 

· For Android devices: Go to Market icon on your device, search for doForms and install the free app.

· For iOS devices:  Go to App Store on your device, search for doForms, and install the free app.

Lesson 4.8.3: Setting up the doForms Web Services

1. On the main doForms menu go to Manage > Account:
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Under Manage Your Website, choose Web Services:

3. Under the Action column, click the dropdown button and select Add service:
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4. Select your form from the Form name dropdown field and enter a password of your choice in the Password field then click Add.

NOTE: The password entered MUST BE THE SAME FOR ALL YOUR FORMS in order for the interface to retrieve data from the form. 
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Lesson 4.8.4: Setting up the Hach WIMS Interface
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Download the doForms Web Service Interface (Q14162) from http://www.opssys.com/instantkb/Article.aspx?id=12932 or the support portal ( www.hach.com/im) and install on the WIMS server.

2. 






2.  Launch the interface from the Windows start menu by choosing Run Interface in Interactive Mode 
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3. Go to Configuration > Connection to Hach WIMS and enter the location of the Hach WIMS database in the Data Source box.  Click Test Connection to ensure the Data Source was entered correctly then click Save Settings.  Click Close when finished.
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4. Go to Utilities > Upload definition file to Hach WIMS, then select the 14162.g2_server_lu file and click Open.  You should get a message stating “Upload Successful”.
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5. Open Hach WIMS and go to System Setup > System Tables > Entire System > Server-Side Interface Setup.
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6. Click New
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7. Select the doForms Web Service from the list of available interfaces and click Next.
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8. Select the latest version from the list (there may only be one) and click Finish.
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9. Enter the Name of Interface, Description, Collector Time Zone, and Interface’s AuditUser Name fields and click OK.
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10. Exit WIMS and return to the Interactive Mode screen for the doForms Web Service.

11. Go to Configuration > Collector Configuration and select the Name of Interface you chose in the previous setup.  Click Save Settings and Close when finished.
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Go to Configuration > Source Configuration
13. Enter your doForms Account name and the Password you set previously for the forms created and click Save Settings and Close:
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14. Go to Configuration > Automated Import Configuration:
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15. Choose how often the doForms Web Service should check for new data from the doForms website.  Click Save Settings and Close when finished:
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Lesson 4.8.5: Configuring Hach WIMS Variables

1. Go to the Interface tab within the variable which is going to store the data from the mobile device:
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2. Select the Interface To radio button and the name of your doForms Web Service from the dropdown box:
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3. Enter the doForms ‘Data Name’ of the field you want to store in this Hach WIMS variable in the Data Name field exactly as it appears on the doForms website and enter “Yes” in the Enable Import field to make this variable interface active:
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4. Repeat these steps for each variable that will contain doForms data.

Lesson 4.8.6: Entering Data on Mobile Device

1. Open the doForms application on the mobile device:
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Set your mobile number to be the same as when the device was added to your account on the doForms website and click Next:

3. [image: image604.png]TN Eer—
5 | Comectionto Hochwivis

[EEG  Collector Configuration

S
tomated Import Configuration

Advanced Confguration

Save Al Configuration




Set your PIN to be the same as when the device was added to your account on the doForms website and click Next:
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Click the Test Account button and click Done once you receive the Account Connection Successful screen:
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The application will run an automatic update to download all of the forms within your account to the device.

6. Click on Forms:
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Select the form for which you wish to enter data and click Start:

8. Click on the first field, enter or select the correct data and click the right arrow to move to the next field:

[image: image391.png]Collection Date Collection Date

Efflent pH

Effent BOD

Weather Conditons





9. Repeat Step 8 for each field on the form:
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10. Click Close when complete to view all fields on the form:
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11. Click Menu > Save and Send to initiate the upload to the doForms website.  You will receive a confirmation if data was successfully uploaded:
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Once the Hach WIMS doForms Web Service runs on the automated basis which was defined during setup, the data sent from the mobile device will be available in WIMS:

Lab 4.9: Working with Multiple Facilities

WIMS has a variety of tools to use data from other facility databases including:

· Spread Reports Locate Data from Other Facilities 
· SQL Results

· Calc Engine @ function

· WIMS to WIMS Interface
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Example 1 – Pull data from the Wastewater Tutorial database into a Spread report.

1. Go to Design, Spread Reports.
2. Click on cell B4 and go to Locate, Other Facility Values

3. Choose the facility database Wastewater Tutorial:
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4. Choose the variables to view.  In this example, chose Influent Flow, Influent BOD and Influent TSS.  Highlight variables on the left and use green arrow to select.  Click [image: image395.png]
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5. Data will be placed on the report
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The Locate function uses the SQLFIRST function to pull the data:

SQLFIRST returns a value of the SQL Query result into a Spread Report. If the result of the SQL Query is a table of more than 1 column by 1 row, SQLRESULT must be used to retrieve other values.

SYNTAX: 

SQLFIRST(Col, Row, "Facility","SQL Query", MaxColumns, MaxRows, Parameter1,…,Parameter20)

Col: Column number to retrieve result from

Row: Row number to retrieve result from

"Facility": Facility to query against, specified by its unique identifier. If left blank(i.e. ""), current facility is used.
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"SQL Query": SQL select statement to execute

MaxColumns: Specifies the number of columns in the resulting table

MaxRows: Specifies the number of rows in the resulting table

Parameter1..20: OPTIONAL. External values to be used substituted into the query, should the query refer to them.  In SQL Query, use @Px@ to refer to the parameter, or #Px# to refer to the parameter as a date, $Px$ as a number.

Example 2: Get the average for OPSWWTUTOR – V901 Rainfall
1. Find the VarId for V901 Rainfall.  Log into the Wastewater Tutorial.  Go to System Setup, Edit/View Variables.  Browse to V901 and the varid is displayed in the lower right corner:
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2. Log back into the Drinking Water Tutorial and go to Design, Spread Reports.  Locate the Start Date and End Date of the report in cells B2 and B3:
3. Enter the following formula:

=SQLFIRST(1,1,"OPSWWTUTOR","SELECT AVG(CURVALUE) FROM DATATBL WHERE VARID=9 AND DATESTAMP>=#P1# AND DATESTAMP<=#P2#",1,1,B2,B3)
[image: image400.png]BS _..|-SQLFIRST(11,"0PSWWTUTOR""SELECT AVGICURVALUE) FROM DATATBL WHERE VARID=3 AND DATESTAMP>=HP1# AND DATESTAMP<=#P2H"

8283 "

&

s T ¢ o & [ 7 [ < W i f 3 T T 3
aoe
o2n81s 4

5’,’.“.“”_

b

—— ==t =5




Example 3:  Use a calculated variable to pull Influent Flow from OPSWWTUTOR:

The Math Toolbox @ function allows you to reference a variable in a different facility.

1. In the Drinking Water tutorial, go to System Setup, Edit/View Variables.  
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Click [image: image401.png]


 and fill out form as follows:

3. Click on Equation tab and enter formula of V1@OPSWWTUTOR.  Click Check Equation:






4. Bring up a Monthly Data Entry form.  Insert v4697 and click calculate:  














Example 4: Using the WIMS to WIMS interface

The Hach WIMS Direct Server-Side Interface to Hach WIMS is designed to sync data between two or more Hach WIMS facilities. The interface can communicate between an Oracle Hach WIMS client and a MS SQL Hach WIMS client.

Variables in the destination Hach WIMS facility are matched to variables in a source Hach WIMS facility. The data that is synced between facilities, is the value contained in the variables from the source Hach WIMS facility. The interface will update values from the source facility to the destination facility based on the audit trail information. The interface reads the audit trail information in chronological order and performs the last transaction of the time slot to update the destination Hach WIMS facility.

The WIMS to WIMS interface is used in lieu of the Math Toolbox @ function when a large number of variables are being transferred (several hundred) as the WIMS to WIMS interface is more efficient than the calc engine.

NOTE:  The WIMS to WIMS interface is a licensed interface and will require an available Server-Side Interface license.  

1. Install the WIMS to WIMS Interface.  Can be downloaded at http://www.opssys.com/instantkb/Article.aspx?id=12932 

2. Create a variable to receive the data.  Click on the interface tab and enter the Unique Facility Id and the VarId.  
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Lab 4.10: Hach LAB Cal™ Sample Scheduling and Tracking Add-on
LAB Cal is a sample scheduling and tracking add-on to WIMS.  Hach LAB Cal provides simple sample scheduling and tracking solution for lab data management. The software automatically builds a calendar that shows at-a-glance the status of all samples, tests to be run, chain of custody and more.



See http://www.opssys.com/instantkb/Article.aspx?id=12887 for more information.  Use the LAB Cal training manual for more in-depth training.

Lab 4.11: Hach JOB Cal® Plus – Maintenance Management Solutions
JOB Cal Plus provides easy-to-use maintenance tracking and scheduling for drinking water, wastewater and industrial markets. The software helps to improve productivity and efficiency of the maintenance department with intuitive screens and easy access to information. Work orders can be created and edited, with all job information stored in a history file. Calendars are automatically updated by the system, providing real-time and accurate information for users. The software also provides inventory tracking, support materials and flexible security options for each user.
See http://www.opssys.com/instantkb/Article.aspax?id=12887 for more information.  Use the JOB Cal training manual for more in-depth training.

Lab 4.12: Hach BOD Manager™
The Hach BOD Manager software automates data entry and calculations from the HQ40d Meter and LBOD probe, providing improved productivity and data integrity for Biochemical Oxygen Demand testing. This software is included with the software and can also be purchased as a stand-alone solution. 

See http://www.opssys.com/instantkb/article.aspx?id=11918 & http://www.opssys.com/instantkb/article.aspx?id=11630 
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